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Disclaimer 

All products manufactured by Xenics nv are warranted as laid down in the sales conditions. 
 
Xenics nv has no other obligation or liability for defects than those set forth therein. 
 
No other warranty is expressed or implied. Xenics nv specifically disclaims the implied warranties of merchantability and 
fitness for a particular purpose.  
 
This warranty will no longer be valid if the instructions contained herein are not followed. 
 
Xenics nv shall not be liable for any direct, indirect, special, incidental or consequential loss of damage, whether based on 
contract, tort, product liability or any other legal theory. 
 
Copyright/Intellectual Property Rights 

© Xenics nv 2016. 
  
All rights reserved worldwide.  
 
This document must not, in whole or part, be copied, photocopied, reproduced, translated or transmitted to any electronic 
medium or machine readable form without written permission from Xenics nv. 
 
Names and marks appearing on the products herein are either registered trademarks or trademarks of Xenics nv. All other 
trademarks, trade names or company names referenced in this document are used for identification only and are the property 
of their respective owners 
 
Quality Assurance 

The Quality Management System under which these products are developed and manufactured has been certified in 
accordance with the ISO 9001 standard.  
 
Xenics nv is committed to a policy of continuous development for which we reserve the right to make changes and 
improvements on any of the products described in this manual without prior notice.  
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1. Introduction 
Before being able to start the camera, the Xeneth imaging suite and its graphical user 
interface must be installed, so that the data coming from a wide variety of Xenics detectors 
and cameras can be easily operated on and analyzed. 

Target group: This technical manual is written for professional users. 
 
 Please read this manual thoroughly before installing Xeneth!  
  

1.1. Manual Overview 
This section provides a chapter overview: 

• Chapter 1 (this chapter) gives an overview of the conventions used in this manual 
(styles and symbols), the safety warnings, conformity information about Xenics 
cameras and the contact information. 

• Chapter 2 lists the minimum system requirements. 
• Chapter 3 describes the Xeneth installation and removal. 
• Chapter 4 describes the camera connection. 
• Chapter 5 contains the use of the Xeneth menus and tabs, image processing, 

troubleshooting, some scripting samples and an introduction to the SDK. 
• Chapter 6 collects references to several features concerning thermography. 

1.2. Conventions Used in This Manual 
To give this manual an easily understood layout and to emphasize important information, 
the following typographical styles and symbols are used:  

The styles used in this manual are: 

• Bold : used for highlighting important things 
• Courier New: used for code listings and output. 
• Italics: used for UI elements, modes and fields. 

The symbols used in this manual: 

 Note: This symbol highlights important information.  

 Warning: This symbol highlights important instructions. These instructions 
must be followed to avoid malfunctions! 

i 

! 
 

i 
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1.3. Safety Warnings 
The following safety warnings must be followed: 

 Supply voltage polarity : Use the correct polarity of the 12 V supply voltage. 

 

 
 

Warranty : The warranty becomes void in case of unauthorized tampering or 
any manipulations not approved by the manufacturer. 

 Electrostatic discharge : The camera contains sensitive electronic 
components which can be destroyed by means of electrostatic discharge. 
Use sufficient grounding to minimize the risk of damage. 

For camera models with Camera Link interface first connect CL camera and 
grabber with Camera Link data cable, and afterwards supply power to the CL 
camera. 

 Environmental conditions : Operate the camera in dry and dust free 
environment. 

Regarding the signal quality of the camera it is an advantage to operate the 
camera under constant ambient air temperature (~20 °C). 

Beneath or above ambient temperature a sufficient heating or cooling may 
be necessary. 

 Warm-up Period : Depending on the prevailing environmental conditions, 
some time might pass after the camera start, until the image quality reaches 
its optimum.  

  

i 

! 
 

! 

! 

! 
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1.4. Contact Information 
• Xenics nv (Headquarters) 

Ambachtenlaan 44  
BE-3001 Leuven 
Belgium 
T +32 16 38 99 00 
sales@xenics.com 
 
Xenics USA, Inc.  
North and Latin American office  
600 Cummings Center,  
Suite 166-Y  
Beverly, MA 01915-6194  
United States of America 
T +1 978 969 1706  
sales@xenics-usa.com  
 

• sInfraRed Pte, Ltd 
Asian sales, manufacturing and custom solutions office 
Blk 28 Sin Ming Lane #06-143, Midview City  
Singapore 573972  
T +65 6 47 666 48 
sales@sinfrared.com 
 

• Xenics LLC  
Russian representative and service center  
Dmitrovskoye Highway, 9A/5  
127434 Moscow  
Russia  
T +7 985 763 4526  
sales@xenics.ru 
 

• Distributors worldwide 

Xenics is a European based provider of infrared imaging products and has 
representatives and distributor locations around the world to service our many 
customers.  

Please visit our website for more contact details: 
www.xenics.com  
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2. Prerequisites 

2.1. System Requirements 
In order to run Xeneth, the minimum system requirements are: 

• Windows XP (32 bit, SP3 minimal), Vista (32/64 bit, SP2 minimal), Windows 7, 8 and 
10 (32/64 bit) 

• 2 GB RAM or more 
• Gigabit  Ethernet network interface for GigE Vision cameras 
• 100 Mb Ethernet network interface for cameras using the proprietary Xenics network 

protocol.  
• USB 2.0 Hi-Speed ports for cameras with a USB interface 
• A frame grabber compatible with Xeneth  for cameras with a Camera Link™ interface: 

o National Instruments  
• NI PCI-1428 (http://sine.ni.com/nips/cds/view/p/lang/en/nid/208265) 
• NI PCIe-1429 (http://sine.ni.com/nips/cds/view/p/lang/en/nid/14518)  
• NI PCIe-1433 (http://sine.ni.com/nips/cds/view/p/lang/en/nid/208913) 

o Euresys GRABLINK™ Series  
• http://www.euresys.com/Products/grablink/GrablinkSeries.asp  

o ImperX FrameLink™ Series  
• VCE-CLEX01 (http://imperx.com/frame-grabbers/vce-clex01/)  
• VCE-CLEX02 (http://imperx.com/frame-grabbers/vce-clex02/)  

• Any other Camera Link™ frame grabber that supports serial communication via the 
standard CLALLSERIAL interface can be used to set up a command and control 
session.  

• USB Memory stick for installation 
• Display resolution of 1024x768 or higher (1920x1080 preferred) 
• High speed storage. For instance the Cheetah CL camera (640x512, 16 bit, 400Hz) can 

produce in excess of 245 MB/s. 
• CPU that supports the SSE2 instruction set. 

 
 

 

2.2. Applications 
Xeneth can be used in the following applications: 
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• SWIR/VISNIR/MWIR/LWIR imaging 
• Thermography 
• High speed imaging & recording 
• Real-time analysis/monitoring of thermal/infrared processes 
• Post processing of thermal/infrared processes 
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3. Installation 

3.1. Installation Sequence 
 It is a good practice to first uninstall a previous Xeneth version when 

installing a new one. 

 When using Camera Link cameras, it is also necessary to pre-install the 
frame grabber before installing Xeneth! 

Follow the next installation sequence to avoid problems: 

1. Uninstall a previous Xeneth version 
2. First install the frame grabber drivers when using a frame grabber for Camera Link 

cameras (see chap. 3.3.2). 
3. Install Xeneth (see chap. 3.2) and mark the frame grabber checkbox (Figure 3-4). 
4. Install the Xeneth. 

3.2. Xeneth Installation 
When installing the software, Figure 3-1 shows the language selection dialog box to 
choose the user interface language. 

 

Figure 3-1 Language selection 

The Language → Welcome page provides information about the SW version being 
installed as shown in Figure 3-2. 

! 
 

! 
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Figure 3-2 Xeneth Setup wizard 

When clicking ‘Next’ the Language → Welcome → License page is shown (see Figure 3-3). 

 

Figure 3-3 License agreement page 
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The license page contains the copyright notice and copyright notices about the software 
components used. 
Proceed by checking the ‘I accept the terms in the License Agreement’ checkbox. When 
clicking ‘Next’ the Language → Welcome → License → Components page is shown (see 
Figure 3-4). 

 

Figure 3-4 Components selection page 

As shown in Figure 3-4, the ‘Device support’ category may be necessary for acquisition 
over third party drivers or cards, such as Camera Link™ frame grabbers. 

3.3. Device Support 
The device support sub category contains items that may be necessary to get access using 
third party drivers or cards. 

The following two device support categories exist: 

3.3.1. Camera Drivers (USB) 
The USB driver must be installed to support the Xeva line of cameras. The first time the 
camera is plugged – in new hardware will be detected, recognized and installed. 
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3.3.2. Camera Link™ 
The options from the following sub categories can be selected to install the desired frame 
grabber plug-in for frame grabbers that are natively supported by our software. The 
available plug-ins are used for grabbing the frames from the acquisition board and do 
provide an interface to the board-specific settings. 

To enable serial communication over the Camera Link™ serial lines to the camera, Xeneth 
makes use of the clallserial.dll specification from the Camera Link™ standard API. This is a 
wrapper to other brand specific DLLs that comply with the clserxxx.dll naming convention 
and API definition.  A dedicated clserxxx.dll should be shipped with all Camera Link™ 
compatible brands and should be located where the value of CLSERIALPATH points to. To 
obtain this value look in the HKLM registry under the key “SOFTWARE\Cameralink”. 

The binary clallserial.dll is always installed with Xeneth and enables the user to use 
command and control with any brand that complies with the standard clserxxx.dll API 
specification. 

 When a frame grabber is used for which Xeneth does not provide a plugin, 
always make sure the frame grabber specific clserxxx.dll resides at the 
correct path! 

 When Device Support for an integrated frame grabber is selected, the 
installer adds a copy of the corresponding clserxxx.dll to the root installation 
folder and updates the key CLSERIALPATH. Note that this could interfere 
with other software applications. 

 

 

3.3.2.1. National Instruments (Camera Link) 
Select this option (see Figure 3-4) to install the National Instruments frame grabber plug-in 
for use in combination with our Camera Link™ enabled cameras. 

This option also installs the .ICD files that contain the camera and board specific 
configurations into the camera files path of NI. The path is obtained from NIIMAQPATH in 
the HKLM registry, location “SOFTWARE\National Instruments\NI-IMAQ for Windows 
95/NT”. 

A copy of clsernat.dll is placed in the root installation folder of Xeneth and CLSERIALPATH 
is updated. 

! 
 

! 
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 The National Instruments Image Acquisition installation procedure must be 
completed before installing the Xeneth software. The installation CD and 
installation manual is provided by National Instruments  together with the 
frame grabber card.  

3.3.2.2. Euresys (Camera Link) 
Select this option (see Figure 3-4) to install the Euresys frame grabber plug-in to use the 
GRABLINK™ series acquisition boards in combination with our Camera Link™ enabled 
cameras. 

This option installs the .cam files that contain the camera specific configurations into the 
camera files path of Euresys. The path is obtained from CAMERAS in the HKLM registry, 
location “SOFTWARE\Euresys\MultiCam\Parameters”. 

A copy of clseremc.dll is placed in the root installation folder of Xeneth and 
CLSERIALPATH is updated. 

 The Euresys MultiCam studio installation procedure must be completed 
before installing the Xeneth software. The installation manual is provided by 
Euresys  together with the frame grabber card. The software needs to be 
downloaded  from www.euresys.com > DOWNLOAD. 

 

3.3.2.3. IMPERX (Camera Link) 
Select this option (see Figure 3-4) to install the IMPERX frame grabber plug-in to use the 
FrameLink series acquisition boards in combination with our Camera Link™ enabled 
cameras. 

This option installs the .cxf files that contain the camera specific configurations into the 
GrabberFiles folder of Xeneth. 

A copy of clseripx.dll is placed in the root installation folder of Xeneth and CLSERIALPATH 
is update. 

 The IMPERX installation procedure must be completed before installing the 
Xeneth software. The installation manual and software is provided by 
IMPERX together with the frame grabber card.  

 If the IMPERX installer is not installed using the default installation directory 
the Xeneth GUI application is unable to find the required IMPERX SDK 
runtime DLLs. When Xeneth is installed with the IMPERX option checked a 
configurable path property is appended in Application Settings � Frame 

! 
 

! 
 

! 
 

! 
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grabber options named Imperx SDK path to allow the user to configure a 
custom path. (See chap 5.2.3.) Make sure to set this path to the correct 
location taking into account the version of Xeneth (32 or 64 bit) installed. 

 

3.4. Plug-ins and Scripts 
The Plug-ins & Scripts category contains additional filters/scripts that are used to perform a 
number of image processing tasks. 
Select the required components, and click ‘Next’. 

The Language → Welcome → License → Components → Install location page is shown in 
Figure 3-5. 

 

Figure 3-5 Install location page 

Choose the location in which Xeneth must be installed.  

Choose the installation location, and when clicking ’Next’, the Language → Welcome → 
License → Components → Install location → Start menu page is shown (see Figure 3-6). 
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Figure 3-6 Start menu page 

This page determines the Xeneth location in the start menu.  
Choose the start menu folder, and when clicking ’Next’, the Language → Welcome → 
License → Components → Install location → Start menu → Install page is shown (see 
Figure 3-7). 

 

Figure 3-7 Installation page 

During installation, when the USB drivers were selected to install, an additional dialog will 
pop up as shown in Figure 3-8.  
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Figure 3-8 USB driver installation page 

When clicking ‘Next’, Figure 3-9 is shown. 

 

Figure 3-9 End user license agreement page 

Proceed by accepting the end user license agreement and click ‘Next’. 

The USB driver is installed at this point, as shown in Figure 3-10. 
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Figure 3-10 Installation end page 

Click ‘Finish’ to proceed with the rest of the installation. 
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Figure 3-11 Finish installation 

 

Find the Xeneth shortcut ( ) on the windows desktop. Double click it to start the 
application. 

3.5. Xeneth Documentation 
After the Xeneth installation, the Xeneth User Manual can be found in the following Xeneth 
installer folder and in the Help tab within Xeneth: 

− C:\Program Files\Xeneth 
(64 bit Xeneth installed on a 64 bit operating system or 32 bit Xeneth installed 
on a 32 bit operating system). 

− C:\Program Files (x86)\Xeneth 
(32 bit Xeneth installed on a 64 bit operating system). 

 



 User Manual 

Xeneth v2.6 

Company confidential.  
This document is the property of Xenics. It may not be reproduced – completely or partially – or passed to a third 

party without written permission from Xenics. 
 
Xenics nv  T +32 16 38 99 00            Doc Ref: ENG-2013-UMN020 
Ambachtenlaan 44  F +32 16 38 99 01  Issue: 001 
BE-3001 Leuven � Belgium www.xenics.com  Date: 27/05/2016 
  XF-104_02/20-01-2012 

 
Page 32 of 152 

 

 

3.6. Uninstall 
When selecting the Xeneth uninstall option, Figure 3-12 is shown. 

 

Figure 3-12 Xeneth uninstall 

Click ‘Yes’ to remove the Xeneth software. Afterwards the uninstaller will prompt whether or 
not the data stored in the “C:\program files\xeneth\Calibrations” is discarded (see Figure 
3-13).  

 

Figure 3-13 Xeneth uninstall – Calibration data 

Click ‘Yes’ to keep the data. 

The following figure is shown afterwards: 



 User Manual 

Xeneth v2.6 

Company confidential.  
This document is the property of Xenics. It may not be reproduced – completely or partially – or passed to a third 

party without written permission from Xenics. 
 
Xenics nv  T +32 16 38 99 00            Doc Ref: ENG-2013-UMN020 
Ambachtenlaan 44  F +32 16 38 99 01  Issue: 001 
BE-3001 Leuven � Belgium www.xenics.com  Date: 27/05/2016 
  XF-104_02/20-01-2012 

 
Page 33 of 152 

 

 

Figure 3-14 Xeneth uninstall – Close 

When clicking the ‘Close’ button, the uninstaller will proceed to remove the Xeneth software 
and its API. 
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4. Getting Started 

4.1. Connecting the Camera using USB 
Connect the camera to its power supply, and proceed to connect the camera’s USB port to 
the PC using the Xenics cable. 
When any new hardware detected dialogs from windows pops up, refer to chap. 3 
Installation. It is possible that the USB driver was not installed, or the proper procedure was 
not followed. 

4.2. Connecting the Camera using GigE 
Connect the camera to its power supply, and proceed by connecting the camera’s Ethernet 
connection to the local network (Cat 5e or better). 

 Alternatively, it is possible to connect the camera directly to the PC, but keep 
in mind that if the PC has a 100mbit NIC, a crossed UTP cable must be used 
instead of a regular UTP cable.  

 Please keep in mind that an Ethernet network is being built. If the camera in 
question does not have Zero Configuration support, a DHCP server must be 
available, so that the camera can be assigned an IP address. 

 When the camera is located on a different subnet it is still possible to 
connect to the device by assigning a new IP address using the Force IP 
procedure defined by the GigE Vision standard. For more information on 
how to enable this feature refer to chap. 5.2.1.4. 

4.3. Connecting the Camera using Camera Link 
If a compatible Camera Link™ card is available and the camera has a Camera Link port 
available, connect the Camera Link cables at this point.  

 Keep in mind that for cameras with multiple Camera Link outputs, great care 
has to be taken as to which cable to be plugged into which slot. Always pay 
attention to the Base/Medium designations on both the camera housing and 
the grabber. 

 Not all cameras allow commands to be sent over Camera Link. These 
cameras must be used in combination with an additional connection (e.g. 

! 
 

i 

! 
 

i 

! 
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USB) for command and control. 

 

5. In Depth 

5.1. Connection Setup – Manual 
 

  

Figure 5-1 Connection setup 

Using the manual connection dialog it is possible to immediately type in the URL of the 
camera the user wishes to establish a connection with in the location text box. Currently 
GigE Vision and the Xenics Network and Serial Protocols are URL enabled. These are 
explained in depth in chap. 5.1.1 on Uniform resource locator (URL). A history of ten URLs 
is kept and can be accessed using the drop-down arrow. 

After entering a valid URL any calibration pack can be selected using the Calibration data 
drop-down list. Make sure to select the correct pack for the type of camera. If the 
calibration pack was not loaded correctly it will be reported in the status area. We refer to 
chap.5.3 for the location of this field. 

When a valid location and optional calibration pack was entered a connection can be 
established using the Connect-button, the help-button is used to open this manual. 

Toggle between the manual 
or enumeration dialog 
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If you want to immediately start capturing when the connection was successfully 
instantiated make sure to check the “Start capturing on connect”-checkbox. 

 When this checkbox is unchecked, press the  start capturing button to 
start acquiring images, even when playing back an XVI movie. 

Using the expansion button the enumeration dialog is shown. More information on the 
enumeration dialog is handled in chap.5.2. 

 

5.1.1. Uniform Resource Locator (URL) 
All URLs follow a common scheme using the format 
protocol-name  : [ // ] location [ / ] [ ? query-string  ] 

protocol-name  is a 3 to 4 character abbreviation used to identify the protocol to use.  

location  is the unique location identifier compatible with the protocol domain. 

query-string  is an optional part of the URL which allows the user to pass some extra 
configuration options in special cases. The format is key=value . 

Parts inside the square braces  [] are optional and can be omitted while still holding a valid 
URL. 

Protocol Protocol - name Location Remark 

Xenics serial protocol xsp COM0 … COM255 Via PC serial port 

Xenics serial protocol xsp CL0 … CL255 Via Camera Link serial port 

Xenics network protocol xnp ipv4 ethernet address  

GigE Vision gev ipv4 ethernet address  

Table 5-1 URL scheme 

 

Key Value xsp xnp gev Remark 

fg none X X X Connect the camera for command and control. 

nif 0 … 255 X X  Select a Camera Link interface. 

forceip {Ipv4; Ipv4; Ipv4}   X See force IP in chap 5.2.1.4. 
See example below. 

bitsize 8, 16, camera X X X Applicable to cameras that have selectable bit 
depth. 

! 
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camfile File path X   Suggest an alternative camera file to the frame 
grabber. 

Table 5-2 URL scheme – Query string 

 

Examples: 

• “gev://10.0.0.1” opens a connection to a GigE Vision camera with IP address 
10.0.0.1 for command and control and image grabbing. 

• “gev://192.168.1.12?fg=none” opens a connection to a GigE Vision camera with IP 
address 192.168.1.12 for command and control only. 

• “xnp://10.0.0.1” opens a connection to a Xenics network camera with IP address 
10.0.0.1 for command and control and image grabbing.  

• “xnp://192.168.1.12?fg=none” opens a connection to a Xenics network camera with 
IP address 192.168.1.12 for command and control only.  

• “xnp://192.168.1.12?nif=CL0” opens a connection to a Xenics network camera with 
IP address 192.168.1.12 for command and control and image grabbing over the first 
detected Camera Link channel.  

• "xsp://COM1" opens a connection to the serial COM port. Since COM ports do not 
support any frame grabbing this session will start as command and control only. 

• "xsp://CL1" opens a connection to a Camera Link camera. Because Camera Link 
channels support image grabbing this will open a session for both command and 
control and image acquisition. 

• gev://192.168.2.100?forceip={192.168.1.100;255.255.255.0;192.168.1.1}. Open a 
connection to a camera and force it to change its IP address to 

o 192.168.1.100 is the imposed IP address 
o 255.255.255.0 is the imposed network mask 
o 192.168.1.1 is the imposed local gateway. 

 
 

 

5.2. Connection Setup – Enumeration 
The connection setup dialog is divided into several tabs. The Enumerate devices and 
Enumeration settings- tabs can be used to configure options specific to device 
enumeration. The Application settings-tab allows configuring features specific to the 
graphical user interface. The following paragraphs provide an overview followed by an in 
depth description of the different components and settings. 
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5.2.1. Enumerate Devices 
 

   

Figure 5-2 Enumerate devices 

5.2.1.1. Device List 
This component holds a list of all the devices found during the enumeration procedure. A 
tool tip containing basic information about a device can be obtained by placing the mouse 
above one of the items.  

The items in the device list are formatted such that the user can instantly identify the 
camera by serial number and model name.  The status icon immediately tells the user if he 

 

The device list with sort option 
for sorting the list items based 
on transport, name or serial 
number. The item is prefixed 
with a status icon. A green icon 
indicates the device is 
available, red means the device 
is busy and a black icon 
indicates that the device is 
unavailable. When the mouse is 
hovering over an individual item 
a tooltip is shown with the basic 
device information. 

The device information holds 
camera specific details of the 
selected camera. This section is 
split into several tabs to enable 
protocol specific options.  

Toggle between the manual or 
enumeration dialog 



 User Manual 

Xeneth v2.6 

Company confidential.  
This document is the property of Xenics. It may not be reproduced – completely or partially – or passed to a third 
party without written permission from Xenics. 
 
Xenics nv  T +32 16 38 99 00            Doc Ref: ENG-2013-UMN020 
Ambachtenlaan 44  F +32 16 38 99 01  Issue: 001 
BE-3001 Leuven � Belgium www.xenics.com  Date: 27/05/2016 
  XF-104_02/20-01-2012 

 
Page 39 of 152 

 

is able to connect the device. A camera can have three device states: Available , Busy  

or Unreachable . The unreachable state is only shown for GigE Vision cameras when the 
Ignore subnet mask-option is set to True in the Enumeration settings-tab. When the user 
encounters a device in this state, the Force IP procedure has to be performed first before a 
connection can be established (see chap. 5.2.1.4.). 

The device list is also sortable by using one of the sort buttons above the device items. 

•  Sort the list alphabetically in ascending order using the transport name. 

•   Sort the list alphabetically in ascending order using the device name. 

•  Sort the list numerically in ascending order using the serial number. 

When the Auto-scan on load box is checked this dialog will be displayed when the 
application is started and cameras are enumerated automatically. When unchecked the 
manual connection dialog will be shown on startup. 

Use the “Refresh”-button ( ) located at the bottom right of this section to update the list 
of devices. 

When a camera is selected clicking the item in the list the device information-section is 
instantly updated. 

 In case the camera cannot be found in this list, refer to chap. 0   

Troubleshooting Camera Detection Problems. 

  

! 
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5.2.1.2. Device Information 
These fields hold camera specific information. Based on this the user can determine what 
the camera’s model specifications is, what its native protocol is, what its state is and where 
it is located. A calibration pack can be selected using the Calibration data drop-down list. 
Make sure to select the correct pack for your camera. If the calibration pack was not loaded 
correctly, this will be reported in the status area (see chap 5.5). 

 

5.2.1.3. Frame Grabber 

 

Figure 5-3 Frame grabber 

Grabber selection allows the user to select the video stream of the camera. 

Auto-detect  

By default Xeneth will choose the command and control channel to stream the data. If the 
command and control channel is not Camera Link, the user needs to select a camera Link 
port (CL0, CL1, CL2 or CL3). 

Command and control  

The application will open no X-View window, only the Settings panel will be presented to 
the user to enable control of the camera. 

CL0, CL1, CL2 or CL4 

When the command and control channel is different from the streaming channel, the user 
has to enter which Camera Link interface needs to be used. When only one Camera Link 
interface is available it is most likely named CL0. 

Camera file is used to select a custom, manufacturer specific formatted, camera file. These 
camera files can be created and tested with various manufacturer specific tools. If the file 
works in these environments they can be used in Xeneth.  An absolute path should be 
supplied to the camera file. Use the “…” button to open a browse dialog. 

Specify custom grabber 
selection. 

Use the button to open a 
browse dialog for selecting a 
custom camera file. 
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5.2.1.4. Force IP 

 

Figure 5-4 Force IP 

 

The GigE Vision protocol has defined a procedure to recover the camera from an invalid IP 
configuration. To enable Xeneth for enumerating devices that are not using the same 
network configuration as the user make sure to set the Enumeration Settings � Protocol 
specific settings � GigE Vision � Ignore subnet mask option to True.  

After this option is set, the cameras discovered on a different network will be marked with 

the Unreachable state. To force a new IP address, make sure to check the “Enable”-
checkbox in the Force IP tab and enter a new valid IP configuration. This new setting will 
only be retained until the camera has been power cycled again. It is therefore advised to 
configure the IP settings of the camera once the session has been opened such that a new 
persistent IP address is assigned or the camera will get a new address through DHCP after 
the next power cycle.  

 

  

Enter a valid IP address, a 
netmask and the gateway to be 
sent with the Force IP packet to 
enforce the camera in a new 
configuration. Note that this new 
configuration is valid until the 
camera is power cycled. 
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5.2.2. Enumeration Settings 
 

  

Figure 5-5 Enumeration settings 

  

 

 

Enable protocols allows the 
user to specify individual 
protocols to be enabled or 
disabled. This is useful to speed 
up enumeration by specifying 
just the protocol of the devices 
the user wants to discover. 

Using the protocol specific 
settings the user is able to 
configure details of the 
enumeration procedure for 
specific protocols. For GigE 
Vision, Ignore subnet mask 
allows to enumerate devices 
located on a different subnet. 
For serial the user is able to set 
the port ranges that will be used 
during enumeration. 
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5.2.3. Application Settings 
 

  

Figure 5-6 Application settings 

 

 

Set extra camera options 
relevant to the GUI application.  

Configure options only relevant 
to the GUI application and 
interface.  

 
Path to frame grabber files for 
Imperx  
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5.2.3.1. Camera Options 
• Register update interval – Controls the time interval in which the register update 

cursor moves between readable camera registers. 
• Preferred bitsize – This option allows overriding the camera’s default bit size. This is 

only relevant for some cameras which allow variable pixel sizes. 

5.2.3.2. User Interface Options 
Explanation of the General parameter fields in the user interface: 

• Update graphs every n frames – Controls when the user interface will redraw the 
different graphs (Histogram, Graph, Timegraph). 

• Snap span behaviour – Determines the histogram that is taken into account when 
the scale is snapped automatically ( ). 

• Ask whether or not to save settings – When true, the application will prompt to save 
default settings for the camera type attached. 

• Allow rescaling of the view window – When true, it causes the main view to be 
stretched up to touch the window’s edges. 

  When set to false, it may give performance gains when the video card does 
not have hardware acceleration for Stretched Blitting. 

• Fullscreen mode – When the user goes into full screen, the camera image can be 
shown in 3 different modes.  

o Default: Image is scaled to the first boundary. The borders are filled with a 
checkers pattern and the toolbar is visible. 

o Scale: Image is scaled to the first boundary. The borders are filled with black 
and the toolbar will be hidden. 

o Crop: The image is scaled such that no borders are shown. In this case part 
of the image can fall outside the visible area. The toolbar is hidden. 
 

  Images are always centered, unless manual panning of the image was 
performed. To leave fullscreen mode, use the escape button. The fullscreen-
button from the toolbar can also be used if the toolbar is visible. 

• Wait for monitor vertical retrace – When set to true, it forces the software to wait for 
the monitors vertical blanking interval before drawing frames.  

  When undesirable image tearing occurs when operating Xeneth, this should 
be activated. However do note, that this could consume quite some CPU 
cycles due to the way this is implemented in Windows. 

i 

i 

i 
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• Measure thermal filter data only – When true, the effect of image enhancement 

filters is ignored while converting pixel data into temperatures. See chap. 5.9.14  
and chap 6.4.1.  

• Enable SDK tooltips – The features shown in the Settings tab (chap. 5.9.11) are 
available for developers integrating the Xeneth SDK. When this option is activated 
the correct programming names are shown in a tooltip. 

Explanation of the Recording parameters: 

• Automatically generate filenames – When true the user is not prompted to give a 
new file name every time a movie is recorded (chap.5.9.13). 

Explanation of the Units parameter fields in the user interface: 

• Default temperature unit – The unit at which thermal information is displayed: 
(Celsius, Kelvin, Fahrenheit). 

• Distance unit – The distance unit that is used in the UI (pixels, m ,mm, inches, feet). 
• Object distance – The distance to the target for unit conversion  
• Detector pitch – Square pixel size in µm 
• Focal length – The focal length of the lens 

Explanation of the Live camera startup parameter fields in the user interface: 

• Auto start filters – Comma separated list of image filters that automatically will be 
loaded in the Image processing tab (chap.5.9.14): e.g. Matrix, AutoExposure.  

• Auto load tool file – The on-screen selections (tools) file to load at startup. 

5.2.3.3. Frame Grabber Options 
• IMPERX SDK path – This option is only visible when support for IMPERX (Camera 

Link) was selected during installation (chap. 3.3.2.3). When a path different from the 
default installation path is selected, Xeneth needs this information to find the 
IMPERX SDK runtime DLLs. 
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5.3. User Interface Overview 
 

 

 

Figure 5-7 User interface overview 

The Xeneth user interface consists of a number of key elements, such as the menu bar at 
the top of the screen. This is followed by the toolbar underneath it, which contains quick 
access to some of the key functionality such as starting the acquisition, pausing output, 
loading/saving images and activating corrections. The remaining user interface is divided 
into containers that support reorganization of the interface elements, which are called the 
container panels and tabs. The (Settings, Selections, Graph, etc.) tabs can be dragged 
from one container panel to another, which allows the reorganization of the user interface 
to match the available task. 

  

Menus 

Main toolbar 

Scale 

Status area 

Recording 

Selections 

Settings 

X-View 

Image 
processing 

Status bar 

Container panels 
Histogram / Graph / Time graph 

Alarms 
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5.4. Reorganizing the User Interface 
It is possible to drag the Settings, Image processing, Graph, Histogram and Selections tabs 
from the main container (between the display and the scale) to any of the three containers 

below. It is also possible to re-arrange the containers by left-clicking and dragging ( ) 
their title bars to drop them somewhere else in the user interface (see Figure 5-8). 

If a particular container is no longer necessary, it is possible to close it by clicking the ( ) 
button next to its title bar.

 

Figure 5-8 Reorganizing the user interface 

  

Tab 

Container 
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5.4.1. Rearranging Containers 

 

Figure 5-9 Rearranging containers 

To move a container, position the mouse on the name of the window to drag. The mouse 
cursor will change to two orthogonal double arrows. 

Keep the left mouse button pressed. Whilst doing this it is possible to drag the window. 
Release the left mouse button to drop the window in its new location (which is indicated by 
dotted lines while you are dragging). 

Special keyboard modifier: While dragging, and when keeping the ‘CTRL’ key pressed, it is 
possible to decouple the container from the main application, and thus make it free floating. 

 

Figure 5-10 Histogram container 

 It is possible to easily restore the default layout of these containers by 
clicking F12, or going to the View menu and choosing Restore Defaults.  

i 
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5.4.2. Resizing Containers 

 

Figure 5-11 Resizing containers 

To resize containers, select the raised area between two containers, and wait for the cursor 
to change to a double arrow cursor. Now, left-click and drag to change the ratio between 
the two window’s sizes. 

5.4.3. Closing/Reopening Containers 
Close a container window by pressing the ( ) next to its title. 

 

Figure 5-12 Closing a container 

When a container must be reopened that was closed earlier, go to the View menu, and 
click the container that must reappear. 
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5.4.4. Dragging Tabs 
Dragging tabs is quite simple and is a powerful way to get a quick overview of the 
interesting data. 

Left-click and keep the mouse button pressed to see the drag and drop cursor appearing 
(see Figure 5-13). 

 

Figure 5-13 Dragging tabs – Keep left mouse button pressed 

Now move the mouse to another container window and release the left mouse button (see 
Figure 5-14). 
 

 

Figure 5-14 Dragging tabs – Release left mouse button 

5.4.5. Enabling/Disabling Tabs 
The selection of tabs from the main view can be customized through the View menu (chap. 
5.8.2). 
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5.5. The Status Area 

 

Figure 5-15 Status area 

The status area (see Figure 5-15) shows the current camera’s name and connection status 
(Online or Offline). The Reconnect button allows to disconnect from the current camera and 
to return to the connection dialog to reconnect or to select a different camera. 

In addition, the status area shows the currently loaded calibration and its type (i.e. NUC, 
TrueThermal, InGaAs thermal, etc.), as well as any errors that occurred when trying to load 
the calibration. The ‘Select’ button allows selecting a calibration. 

  

5.6. The Title Band 
 

 

Figure 5-16 Title band 

Explanation from left to right: 

• Xeneth vMaj.Min.Beta.Build Basic/Radiometry/Advanced – The Xeneth type installed. 
• Gobi-640-GigE – The camera type. 
• Serial=<x> –The decimal serial number that can be found on the back plate of the 

camera. 
• Pid=<hex>h –The product identifie. 
• 16 bits/pixel – The size of an individual pixel. 
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5.7. Main Toolbar 

 

Figure 5-17 Main toolbar 

Explanation from left to right: 

Parameter Explanation Xeneth version 

Start capture ( ) 
Starts acquiring video data from 
the camera system. 

All  

Stop capture ( ) 
Stops acquiring video data from 
the camera system. All  

Pause ( ) 
Causes the software to freeze the 
output for as long as this button is 
active. 

All  

Load image ( ) 
Loads and displays an image from 
disk. 

Advanced, Radiometry  

Save image ( ) Save the current output to disk. All  

Save sequence ( ) 
Starts the sequence recorder 
(chap. 5.8.3.3 Save Sequence). 

Advanced, Radiometry  
 

Save snapshots ( ) 
Arms the snapshot recorder (chap. 
5.8.3.4 Save Snapshots). 

Advanced, Radiometry  

Non Uniformity Correction (NUC) (

) 

Starts correcting sensor output. 
(chap. 5.9.14.2). The NUC that is 
applied is part of the calibration 
pack that is selected via the Select 
button in the status area (chap.5.5 
) 

Advanced, Radiometry  

Thermography ( ) 
Starts thermal conversion (chap. 
5.9.14.8  and chap. 6). 

 

Restore ( ) 
Restores the camera settings in 
effect during the creation of the 
active calibration pack. 

Advanced, Radiometry  

Show web interface ( ) 
When the camera has a web 
interface, it can be opened here.   

Table 5-3 Main toolbar parameters 
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5.8. Menus 

5.8.1. The File Menu 

 

Figure 5-18 File menu 

Top-down explanation of the file menu: 

• Save settings ( ) – Store the current camera configuration to a file. 

• Load settings ( ) – Restore the camera configuration from a file. 

• Restore defaults ( ) – Restore the camera settings to the settings of the active 
calibration pack. 

• Save tools ( ) – Save the current selections to disk. 

• Load tools ( ) – Restore selections from a file. 

• Print ( ) – Print the current image to any printer (this includes the temperature scale in 
thermography mode). 

• Print preview ( ) – Essentially the same as “Print” but it is possible to inspect the 
image first. 

• Settings ( ) – Open the settings dialog. 

• Exit ( ) – Close the application. 
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5.8.2. The View Menu 

 

Figure 5-19 View menu – basic,advanced,radiometric  

The view menu makes it possible to hide/restore the different containers available in 
Xeneth. 

• Restore view –  Restores the factory default layout of the different containers, and reset 
all panels to default activation and ordering (F12) 

• Panels – Select which panels to show or hide in the interface 
• X-View – The main view window 
• Histogram – Container window 
• Graph – Container window 
• Time graph – Container window. 
• Scale – Window for scale. 

5.8.3. The Image Menu 

 

Figure 5-20 Image menu – basic, advanced, radiometric  

• Start capture – Starts capturing data from the camera. 
• Stop capture – Stops capturing data from the camera. 
• Zoom – The available zoom settings (100% -> 400%) are subset of all zoom 

positions that can obtained via the Main tool bar (chap. 5.7). 
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5.8.3.1. Load Image 
Xeneth offers some live image processing using external images. 

After pressing the load image button ( ) the Windows open file dialog box is shown (see 
Figure 5-21). 

 

Figure 5-21 Open file dialog box 

After selecting the image to load, several options for using the image are shown in the 
Image Processing tab (see Figure 5-22). If the Image Processing tab is missing, enable it 
through the View menu (chap. 5.8.2). 

 

 

Figure 5-22 Show image options 
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Explanation of the show image options: 

• Image operation: 
o Show  – Display the image. 
o Add – Add the image to current camera output. 
o Subtract – Subtract the image from the current camera output. 

• Ambient Temperature 
o Available for thermal images (xpng) only – Set the ambient temperature near 

the object in the image. 
• Atmosphere Temperature 

o Available for thermal images (xpng) only – Set the atmosphere temperature. 
• Atmospheric Transmission 

o Available for thermal images (xpng) only – Set the atmospheric transmission. 
• Image emissivity 

o Available for thermal images (xpng) only – Change the global emissivity of the 
source image. 

• Offset by 
o Shift the input image (thermal / non thermal) by set value (degrees / digital unit). 

Unload the image by removing the filter (Click ). 
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5.8.3.2. Save Image 

After clicking the ‘Save Image’ button ( ) the following save dialog is shown: 

 

Figure 5-23 Save image dialog box 

The following file formats are available: 

• XPNG – An extension to the PNG image format which keeps track of thermal 
calibration information. 

• PNG – This is the standard for storing 16 bit data, is lossless and supported by most 
imaging applications. 

• CSV – Comma separated values. Compliant with Microsoft Excel. 
• BIN – Raw binary, outputs a raw stream of 16 bit values. 
• BMP – This format supports pseudo color output (8 bit). 
• JPG – This format supports pseudo color output (8 bit). 

 

Color 
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Color information will not be saved in a file format that has no (8 bit) RGB pixel data. This 
implies that overlay information that is added by some image processing filters could be 
lost. Moreover, the color profile defined by the scale and its sliders (see 5.9.12 Scale) is 
ignored. 

Alignment 

For cameras with pixels consisting of 12 or 14 bit (and hence having values going up to 
4095 and 16383) a choice must be made on where to put these bits within a 16 bit word. 

• Right aligned – The digital counts are stored as their actual values (0-4095 / 0-
16383) 

• Left aligned – The digital counts are shifted to the left so that white is always 
65535. 

After a filename has been chosen and the save button was hit, the image will be saved to 
disk. 

 The software will also freeze the current output from the camera while being 
in this dialog box.  

 

5.8.3.3. Save Sequence 

After clicking the Save Sequence button ( ) the Sequence recorder options dialog box is 

shown (see ). The same 
file types are available as during a regular image save. 

i 
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Figure 5-24: Sequence recorder options dialog box. 

At the top of the dialog it is possible to choose a filename, and file types that are used while 
recording a sequence of images. The following counter is automatically appended to the 
filename: 

 <your filename>_<counter>.<ext>. 

The control part in this dialog box operates as follows: 

• Wait – Makes it possible to specify a delay in time or in frames before starting 
acquisition. 

• Limit capture to – Specifies the maximum number of frames/time within which to: 
o Skip – Skip n frames/wait n time units and then 
o Capture – Record n frames/n time units. 

5.8.3.4. Save Snapshots 

The save snapshot button ( ) is used to make a series of quick shots. 



 User Manual 

Xeneth v2.6 

Company confidential.  
This document is the property of Xenics. It may not be reproduced – completely or partially – or passed to a third 
party without written permission from Xenics. 
 
Xenics nv  T +32 16 38 99 00            Doc Ref: ENG-2013-UMN020 
Ambachtenlaan 44  F +32 16 38 99 01  Issue: 001 
BE-3001 Leuven � Belgium www.xenics.com  Date: 27/05/2016 
  XF-104_02/20-01-2012 

 
Page 60 of 152 

 

When clicking the button a file save dialogue is shown: 

 

Figure 5-25 Save snapshots dialog box  

The button ( ) becomes armed after which it has the following functionalities.   

• Left mouse click – Saves  <yourname>_<counter>.<ext> to disk 

• Right mouse click – Disarms the save snapshot button ( ). 

 When saving snapshots it is not possible to store files in a .xpng format.  

 

5.8.3.5. png Versus xpng File Format 
To store an image in a xpng format, it is needed that a thermal calibration pack is loaded 
and the thermal filter is active. In that case thermal information is stored as metadata in the 
file. This allows the user to reinterpret the data in the image by adjusting the emissivity of 
the displayed objects and the ambient temperature of the scenery. 

Notice that also the effect of other image filters is neglected when saving the xpng. Again, 
the reason for this is to allow thermal analysis in post processing. 

If a png file is saved, the result is an image after all active image processing filters are 
applied. 

i 
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Having in mind that a side effect of the thermal filter is mapping the image to an image that 
linear in temperature, it is possible to measure temperatures on a png file as well. A 
necessary condition is that no other image filters are active when saving. 

In that case you can derive the temperature from the pixel value. Indeed, the lowest pixel 
value (i.e value 0) corresponds to the lower bound of the temperature range, while the 
highest pixel value coincides with the upper bound of the temperature range. All other 
temperatures can be obtained by linear interpolation. 

 

5.8.4. The Calibration Menu 
 

 

Figure 5-26 Calibration menu 

 

Explanation of the menu items in Figure 5-26: 

• Calibrate camera – Launches the Calibration wizard shown in Figure 5-27. 
• Export calibration data – Exports the current calibration pack to another location in the 

file system. 
• Import calibration data – Copies and activates a calibration pack located in a folder 

different from to Xeneth Calibrations folder. 
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Figure 5-27 Camera calibration wizard 

The following calibration types can be selected (see Figure 5-27): 

• Two point calibration – Perform a full NUC including bad pixel definition 
• Recalibrate offset to compensate for integration time – Modify the offset part of the 

current NUC. 
• Edit bad pixel map – Manually add/remove bad pixel markings from the current 

calibration pack. 
• Temperature calibration (InGaAs) – Allows to correct an active InGaAs thermal 

calibration. 
• Temperature calibration (Planck) – Given knowledge on the spectral behavior of the 

sensor, this wizard allows to make a temperature calibration for cooled cameras. 

 

5.8.4.1. Two Point Calibration 
Two point calibrations (NUC creation) consist of two stages, each of which has its own set 
of tools to classify bad pixels. 

The aim is  
• to adjust the offsets and slopes of the individual pixels in the array to obtain a 

uniform response and to find deviating pixels,  
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• to detect deviating pixels that need to be replaced.  
 
 

Tools 

To make a two point calibration for a camera with NIR/SWIR detector you need a set up in 
which a uniform dark and light image can be generated.  

In case of a MWIR or LWIR camera a uniform and cold image is required. The best results 
are obtained when using a professional flat field black body.   

Prerequisites 

To make a proper calibration it is important that the data collected are representative for 
the context in which the camera will be used. At least the camera should be in a thermal 
equilibrium. For cooled cameras this implies that the cooling is switched on and the sensor 
temperature is at the desired level. For uncooled cameras the sensor and case 
temperature should have reached their steady state. Depending on the type of camera you 
deal with this could take up to 30 minutes. 
 
Data: dark/cold image 

In a first step of the calibration a dark/cold uniform image is needed. Preferably the image 
is as dark/cold as possible, yet all of the responsive pixels should have a strictly positive 
value. 

The minimal requirement is that all responsive pixels do have a value lower than 50% of 
the digital range of the camera. 

In case a TrueNUC calibration (see below) is made, it is needed that for none of the 
integration times in the selected range (responsive) pixels are clipped at zero or have a 
value in excess of 50%. 

When the dark/cold image is not absolutely dark/cold the parameter Keep offset level 
should be selected (Figure 5-32 Two point calibration – Bad pixel criteria and post 
processing) in order to be able observing signals lower than the presented dark/cold image. 
This will be always be the case for thermal cameras. 



 User Manual 

Xeneth v2.6 

Company confidential.  
This document is the property of Xenics. It may not be reproduced – completely or partially – or passed to a third 

party without written permission from Xenics. 
 
Xenics nv  T +32 16 38 99 00            Doc Ref: ENG-2013-UMN020 
Ambachtenlaan 44  F +32 16 38 99 01  Issue: 001 
BE-3001 Leuven � Belgium www.xenics.com  Date: 27/05/2016 
  XF-104_02/20-01-2012 

 
Page 64 of 152 

 

 

Figure 5-28  Histogram dark image - example 1 

 

Figure 5-29  Histogram dark image - example 2 

Data: light/warm image 

In the second step of the calibration a grey/warm uniform image is needed. This image 
should be substantially higher (at least 30% of the digital range) then the dark/cold image. 
However, it is important that none of the responsive pixels is clipped at the maximum level. 

 

Figure 5-30  Histogram light image 
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Calibration wizard: step 1 

              A dark/cold uniform image is required. 

            

 

 

Figure 5-31 Two point calibration – True NUC and bad pixel criteria 

Explanation of Figure 5-31:  

Bad Pixel criteria: 

• Frames to use – The number of frames to be used in the analysis. 
• Fixed pattern noise – Defines a threshold to decide which pixels need to be 

replaced based on their deviating response. 
• Temporal noise – Defines a threshold to decide which pixels need to be replaced 

based on their deviating noise. 
• Tint response non uniformity – Defines a threshold to decide which pixels need to 

be replaced based on their deviating dependency on the integration time. The value 
is only taken into account when the Enable TrueNUC is set to true. 

! 
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TrueNUC: 

A TrueNUC calibration is valid for a range of integration times. When this option is not 
selected the generated calibration pack comes with a fixed integration time.  

 For optimal image quality select a NUC calibration. 

 

• Enable TrueNUC 
o False: a single integration time NUC calibration is made. 
o Linear: the integration time dependency is modelled by a linear function. 
o Polynomial: the integration time dependency is modelled by a higher order 

polynomial curve. Depending of the size of the sensor, this option can last 
for more than 30 minutes. Only select it when you have very good reasons 
to do so. 

• Results – This part of the dialog only pops up after a first analysis is made and 
shows the amount of pixels that are marked for replacement. 

After having entered all parameters push the analysis button ( ) and wait for the result. 

During the fittings step of a TrueNUC calibration an abort icon pops up ( ) which 
can be used to stop the calculations immediately.   

Pixels that are marked as outliers will be colored according to the criteria you have entered. 

If you notice that the criteria you have imposed are too restrictive or too relaxed, they can 
be modified and the analysis can be redone by hitting the analysis button ( ) once more.  

Use the Next button ( ) to go to the second step of the analysis. 

 

Calibration wizard: step 2 

              A grey/warm uniform image is required. 

            

 

! 
 

! 
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Figure 5-32 Two point calibration – Bad pixel criteria and post processing 

Explanation of Figure 5-32: 

Bad Pixel criteria: 

• Frames to use – The number of frames to be used in the analysis. 
• Photon response non uniformity – Defines a threshold to decide which pixels need 

to be replaced based on their deviating response. 
• Temporal noise – Defines a threshold to decide which pixels need to be replaced 

based on their deviating noise.  

Post processing 

• Keep offset level – When false, applying the resulting calibration will lower the 
image value depending on the dark/cold data used during calibration. It is typically 
used to remove the dark current of the sensor. This option should always be true for 
thermal cameras. 

• Black clip – Pixel values lower than this value will be clipped onto this value.  
• White clip – Pixel values higher than this value will be clipped onto this value. 
• Gain adjustment – Multiplication factor applied to each pixel. It is typically used to 

make sure that pixels do not saturate at a value lower than the maximum digital 
value displayed.  
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After having entered all parameters push the analysis button (  ) and wait for the result. 

Pixels that are marked as outliers will be colored according to the criteria you have entered. 

If you notice that the criteria you have imposed are too restrictive or too relaxed, they can 
be modified and the analysis can be redone by hitting the analysis button ( ) once more.  

Use the Finish button ( ) and save the calibration. 

 

After the software has finished writing the NUC data to disk, click the enable image 

correction button ( ) to see the result as shown in Figure 5-33 and Figure 5-34. 

  

Figure 5-33 Uncorrected image 
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Figure 5-34 Corrected image 

 

5.8.4.2. Recalibrate Offset 
This option becomes available when a calibration pack is selected.  

It allows correcting the offset in a NUC calibration.   

When a pack is not loaded, but not activated – Status: Inactive – it is possible to change 
the camera settings in the package as well.  

As a side effect the bad pixel map will be adapted according to the settings in the 
recalibration procedure. 

 MCT/InSb – provided that the camera has a shutter available, the software 
will propose using this MCT/InSb option to perform the offset recalibration. 

 

5.8.4.3. Edit Bad Pixel Map 
This option becomes available when a calibration pack is selected. It is advised to activate 
the software filter before the bad pixel editor is opened. 

The bad pixel map editor allows to mark/unmark bad pixels as assigned by the criteria 
during the two point calibration process. 

! 
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Figure 5-35 Edit the bad pixel map 

 

Explanation of Figure 5-35: 

 The red X button marks a new bad pixel for replacement (see Figure 5-37). 
Notice that in case the Software correction filter is activated the marking will 
be applied immediately to the live image in the XView pane.  

 The green X button un-marks the bad pixel as shown in Figure 5-36.  

 Increase magnification level 

 Decrease magnification level 

 Update the image in the bad pixel editor from the live camera output 
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Figure 5-36 Unmarking a bad pixel 



 User Manual 

Xeneth v2.6 

Company confidential.  
This document is the property of Xenics. It may not be reproduced – completely or partially – or passed to a third 
party without written permission from Xenics. 
 
Xenics nv  T +32 16 38 99 00            Doc Ref: ENG-2013-UMN020 
Ambachtenlaan 44  F +32 16 38 99 01  Issue: 001 
BE-3001 Leuven � Belgium www.xenics.com  Date: 27/05/2016 
  XF-104_02/20-01-2012 

 
Page 72 of 152 

 

 

Figure 5-37 Marking a bad pixel 
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5.8.4.4. Temperature Calibration (Planck) 

 

Figure 5-38 Temperature calibration (Planck) 

The Planck-based thermal calibration wizard allows making a first order thermal calibration 
for cooled cameras. It assumes that the response of the camera is linearly dependent on 
the detected black body (Planck) radiation.  

The user needs to enter a series of measurements in the wizard shown in Figure 5-39. For 
each measurement the camera has to be put in front of a black body at known 

temperature. Next, the ( ) button must be clicked. When all data is entered, click Finish. 

 

 Note: No accuracy is guaranteed.  

 

i 
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Figure 5-39 Temperature calibration (Planck) – Parameters 

 

5.8.4.5. Temperature Calibration (InGaAs) 
This part of the calibration wizard allows updating (recalibrating) a specific kind of 
calibration pack applicable to some NIR or SWIR cameras. The item can only be selected 
when such a camera is connected and the corresponding calibration data is selected.  

Before the wizard is started, a selection should be made containing an object of which the 
emissivity and the temperature is known. This temperature and emissivity should be put 
down in the wizard together with the iris opening (f-number) applied on the lens.  

This procedure can be applied when for some reason or another the camera needs to be 
used with a diaphragm that is different from the one used during calibration. This – 
however - should be done with care and Xenics no longer guarantees full accuracy. 

Root mean squared 

Residual 
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Clear table 

Apply new wavelength 

Offset the entire table using 
a reference 



 User Manual 

Xeneth v2.6 

Company confidential.  
This document is the property of Xenics. It may not be reproduced – completely or partially – or passed to a third 
party without written permission from Xenics. 
 
Xenics nv  T +32 16 38 99 00            Doc Ref: ENG-2013-UMN020 
Ambachtenlaan 44  F +32 16 38 99 01  Issue: 001 
BE-3001 Leuven � Belgium www.xenics.com  Date: 27/05/2016 
  XF-104_02/20-01-2012 

 
Page 75 of 152 

 

 

Figure 5-40 Thermal calibration (InGaAs) 

 

5.8.5. The Help Menu 
 

 

Figure 5-41 Help menu 

Explanation of Figure 5-41: 

• Manual – This document. 
• Camera manual – This provides a brief explanation of the available camera features 

together with the programming name as can be used when building an application 
using the Xeneth software development kit (SDK). 

• About Xeneth – Version and system information. 

 

f - number 

Emissivity of 
the selection 

Temperature 
of the 
selection 
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5.9. Tabs and Containers 

5.9.1. X-View 

 

Figure 5-42 The X-view  

The tools that can be found in the toolbar above the main display can be used to 
manipulate selections, zoom in or out, save line profiles/areas/points and expand the view 
to a full screen state. 

  

X-View tools 

Main display 
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5.9.2. X-View Tools 

 

Figure 5-43 The X-view tools 

Explanation of Figure 5-43 from left to right: 

• Neutral, arrow cursor ( ) – Allows to change the endpoints of selections drawn 
earlier. 

Special keyboard modifier: CTRL – Allows you to pan (move) ( ) a selection to a 
new location. 
When resizing an existing selection, notice the points highlighted in green when you 
hover over them. As soon as being in this highlighted region, it is possible to move a 
single endpoint, or pan both points depending on whether or not you are using the 
keyboard modifier. 

• Select the window of interest region ( ) – Allows to drag one, or multiple rectangular 
windows of interest (depending on camera support) as shown in Figure 5-44. 

 

Figure 5-44 Window of interest 

To create a window of interest: keep the left-hand mouse button pressed and drag a 
rectangular area that contains the region. 

 

Figure 5-45 Multiple windows of interest 
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• Reset window of interest ( ) – Restores the maximum region that can be read 
out. 

• Apply window of interest region ( ) – Sends the coordinates of the window of 
interest to the camera sensor, thus reducing the number of pixels that need to be 
read from the sensor. 

 

Figure 5-46 Applying the window of interest 

• Pixel picker ( ) – Read the pixel of a single pixel. 

 

Figure 5-47 Pixel picker 

To create a point selection, click the left-hand mouse button on a pixel of interest. 

• Rectangular area selection ( ) – Collect statistics of a rectangular area. 

 

Figure 5-48 Rectangular area selection 

To create a rectangular selection keep the left-hand mouse button pressed and drag a 
rectangular area that contains the region. 

• Polygon area selection ( ) – Collect statistics in an area described by a closed set of 
scattered points. 
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Figure 5-49 Polygon area selection 

To create a polygon area, keep the left-hand mouse button pressed and drag out the 
first polygon segment.  By releasing and pressing the left mouse button again a new 
segment will be created. The polygon can be closed by clicking on the starting vertex. 

• Elliptical selection ( ) – Collect statistics of an elliptic selection. 

 

Figure 5-50 Elliptical selection 

To create an elliptic selection keep the left-hand mouse button pressed and drag a 
rectangular area that contains the ellipse. 

• Line profile selection ( ) – Collect the statistics of a line selection. 

 

Figure 5-51 Line profile selection 

To create a line selection click the left-hand mouse button, drag out, and release the 
left-hand mouse button at the end point. 

• Remove selection ( ) – Remove an individual selection by moving the mouse cursor 
to one of its control points and left clicking. 
It is also possible to remove all selections by right clicking in the viewer and selecting 
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Clear all selections. 

 

Figure 5-52 Clear all selections 

• Software zoom ( ) – Allows the mouse’s scroll wheel to zoom and left click dragging 

to pan (scroll) ( ) the display.  
Alternatively the image menu has a zoom feature that does not require the presence of 
a scroll wheel. (See chap. 5.8.3.) 

• Reset software zoom ( ) – Completely zooms out the main view. 

• Save tool output ( ) – Allows to write the selection pixel values of a number of 
consecutive images into a CSV file. 
The format is as follows:  
ToolA data<newline> 
ToolB data<newline>… 

• Toggle overlays ( ) – Allows to turn on and off the RGBA overlay (temperature 
scales, bad pixel highlight, etc.). 

• Fullscreen ( ) – Maximizes the X-View to cover the entire monitor area. The full 
screen mode can be configured in the application settings (See chap. 5.2.3.2): both the 
background and the selection can be adapted. 
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Figure 5-53 Full screen view 
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5.9.3. Selections Tab  

The selections (  ) made using the X-view tools can be found here. If the 
Selections tab is missing, enable it through the View menu (chap. 5.8.2). 

 

Figure 5-54 X-view tools selections 

Explanation of Figure 5-54: 

• Label – Allows changing the name of a selection to something more meaningful. 

• Alarm – Allows monitoring and generating an event based on several selection 
statistics. 

                    

Figure 5-55 Alarm configurator  
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When clicking ‘Start monitoring’, the monitor/event generator will start, when hitting 
‘Stop’, it stops. 

• Emissivity – When changing this parameter the ratio between an objects’ emission and 
reflectance changes. Default a uniform pixel emissivity map of value one is used. This 
map can be changed in the Settings Tab – Thermography (see chap. 5.9.11.2). The 
map can be overruled in any selection by defining a local emissivity between 0 and 1.   
 

 

Figure 5-56 Selecting emissivity 

 

 

Figure 5-57 Emissivity settings 

  

 

Please do not forget to specify an Ambient Temperature in the 
Thermography tab (chap.5.9.11.3).   

 

• Colour – The colour Xeneth automatically attributes to the selection. 

• Type – The selection type, being Line, Point or Area. 

• Info – The control points that determines the selection. 

• Show spatially – Controls whether or not to calculate and draw the statistic on the 

‘Graph’ ( ). 

• Show temporally – Controls whether or not to plot out the statistics in time on the ‘Time 

graph’ ( ). 

• Spatial average – The average value of the pixels in a selection. 

• Spatial minimum – The smallest pixel value in a selection.  

• Spatial maximum – The largest pixel value in a selection. 

i 
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• Standard deviation (spatial) – The standard deviation of the pixels in a selection. 

• Standard deviation (temporal) – The standard deviation of a sequence of average 
values of the selection.   

 Standard deviation (temporal) is calculated using the frames displayed in 
chap. 5.9.7 Time Graph Tab. It is possible to change the number of points it 
is calculated over by editing the X-Axis parameters of the time graph. 

• Transform – Arbitrary execution of mathematical formulae that can be used to compare 
selections with one another. 

 

Figure 5-58 Transform selections 
 

Click the star next to the Transform property for a quick help on this subject. 

 

  

i 
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5.9.4. Selections Tab and Real-time Transformations  
This feature is used to do (simple) real-time calculations on values retrieved when using 
the different image tools at your disposal. 

The formula parser in Xeneth is capable of handling the following operators: 

• + : Add 
• - : Subtract 
• * : Multiply 
• / : Divide. 

The formula parser handles the following variable: 

• VAL:  
o For a line selection, VAL is an array containing the pixel value for each pixel.  
o For an area, VAL is a number that equals the average value over all the 

pixels. 

The formula parser handles the following formulae: 

• AVG(A), MIN(B), MAX(C) in which A is the first selection, B the second and so on. 

This can also be quite useful in combination with the recording option (chap. 5.9.13 
Recording Tab), e.g. when starting the recording or raising an alarm based on the 
difference in temperature in a scene. 

Example: 

 

Figure 5-59 Transform feature – Example 
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In this example the per selection transform feature is used to subtract a reference (the 
average value of all points in selection B, 50 in this example) from the current selection’s 
data points. 

  

Figure 5-60 Entering transform formula 

In Figure 5-60, the formula is entered, but not yet activated. 

  

Figure 5-61 Graph without activating the formula 

 

  

Figure 5-62 Activating transform formula 

When checking the checkbox, the formula becomes active (see Figure 5-62). 

 

Figure 5-63 Graph with activated formula 

The average of selection B is subtracted in real-time from all points in selection A (as 
shown on Figure 5-63). 
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5.9.5. Histogram Tab 

 

Figure 5-64 Histogram 

The histogram ( ) shows the distribution of pixels (Frequency) for a given 
“ADU count” or Temperature value per image.  

5.9.5.1. Zoom in 
The following two ways exist to zoom in on the histogram: 

1. Using the mouse: 

To zoom in, use the zoom icon in the toolbar next to the graph, click the left-hand 
mouse button, drag  out, and release the left-hand mouse button at the end of the 
region of interest. 

 

Figure 5-65 Histogram – Zoom in 
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2. Manually setting the axis scales: 

The second way of zooming in on a graph is by manually adjusting the Axis. Click 
the right-hand mouse button on the graph to get the ‘Graphs options’ menu (see 
Figure 5-66), and select either ‘Format X-Axis’ or ‘Format Y-Axis’. 

 

Figure 5-66 Histogram – Graph options menu 

When a click and drag based zoom was performed before, the auto tick boxes in 
the format axis dialog are already unchecked (see Figure 5-67). 

 

Figure 5-67 Graph options menu – Y-axis format 

To manually enter any values it is sufficient to uncheck the check boxes, and enter 
the value. The major unit and minor ticks settings refer to the interspacing between 
axis labels and the ticks in between them (as shown in Figure 5-68). 
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Figure 5-68 X-axis format – Example 

 

5.9.5.2. Zoom out 

Click the Zoom Out button ( ) to reset the zoom level. 

 Please note that this does not reset the Major / Minor tick settings. To reset 
the tick settings, re-enable their Auto checkbox.  

 

5.9.5.3. Copy Data  
To copy data to Microsoft Excel and other applications select Copy data or Copy image 
depending on whether either a bitmap representation or decimal values are required. It is 
also possible to get a live update in some applications (notably via DDE). See chap. 5.9.8 
DDE Hot Linking.   
 
More information about how to copy images to third party applications can be found in 
chap. 5.9.9 Copying Images to Third-party Applications.  

i 
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5.9.5.4. Inspecting Values 

 

Figure 5-69 Histogram – Graph values 

Clicking the “<<” on the top left corner shows the live statistics section of the graph in which 
the mouse cursor coordinates translated to graph coordinates can be found. 
This makes it easy to quickly inspect the amount of pixels at a provided value/temperature. 

 

5.9.6. Graph Tab 

 

Figure 5-70 Graph tab 

For a line selection the value of each pixel is displayed. For an area selection, the average 
value over all pixels in the selection is displayed.  

This tab supports hot linking data via DDE (Paste as link via Microsoft Excel), zooming, 
copying images, and value inspection. (See chap. 5.9.5 for more details.) 
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5.9.7. Time Graph Tab 

 

Figure 5-71 Time graph tab 

For the time graph the following two distinct modes of operation exist: 

• Min/Max/Avg Mode 
• Pixel History. 

5.9.7.1. Min/Max/Avg Mode 
This mode displays statistics on selections (Statistics can be chosen in chap. 5.9.3 
Selections Tab) and behaves the same as the other graphs. 

 The number of points shown in the time graph can be changed by rescaling 
the X-Axis. The more points that are selected on the X-Axis, the longer the 
History Xeneth will track. This will eventually (for a large number of 
points/selections) reduce the speed of the application.  

 

 The temporal standard deviation computed in the Selections tab is 
calculated for an amount of images that is equal to the amount the length of 
the x – axis.  

 

i 

i 
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Figure 5-72 Time graph 

 

5.9.7.2. Pixel History 
This second mode displays a trace of the default selection’s pixels in time (scrolling 
upward, 256 rows), which is mainly useful for line scan cameras. 

 

Figure 5-73 Time graph – Trace of default selection 

The Time Graph behaves like all other graphs with respect to DDE hot 
linking/zooming/copying images etc. 

 

5.9.8. DDE Hot Linking 
DDE hot linking is a technique used in Microsoft Windows that enables applications to 
share data. In Xeneth this is used to enable live transfer of data from the different graph 
windows to for instance Microsoft Excel. 
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Figure 5-74 DDE hot linking – Graph 

Start by clicking the ( ) copy data icon, or right-click the graph, and select ‘Copy data’. 
Open Excel and select the ‘Paste special’ or ‘Paste link’ option in the Home tab menu as 
shown in Figure 5-75. 

 

Figure 5-75 Excel paste options 

After the paste operation completes, a live link exists to the data of Xeneth’s highlighted 
selection (see Figure 5-76). 
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Figure 5-76 Data in excel 

5.9.9. Copying Images to Third-party Applications 

 

Figure 5-77 Copy image 

Right-click the view window and select one of the following options as shown in Figure 
5-77: 

• Copy image – The image as currently shown is copied to the windows clipboard. 
• Copy image and scale – The image and the temperature bar are copied 
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• Copy image, scale and tools – The image with all active selections and the 
temperature bar are copied. 

Figure 5-78 and Figure 5-79 are an example of an image copied from the main display, and 
the graph belonging to it. 

 

Figure 5-78 Image with temperature bar 

 

Figure 5-79 Graph belonging to the image above 
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5.9.10. Copying Data to Third-party Applications 
See also chap. 5.9.8 DDE Hot Linking and select the normal paste operation, or click 
CTRL-V in the third-party application. 

 

5.9.11. Settings Tab 

Aside from chap. 5.5 The Status Area, this Settings tab ( ) contains the entire 
set of camera and application settings pertaining to the imaging scene. 

 

Figure 5-80 Settings tab icons 

Explanation of the icons from left to right: 

•  - Category view – Organizes the camera settings in logical categories 

 

•  - Alphabetic view – Alphabetically sorts all camera settings 

 

•  - Property visibility level – Select which properties to show 

•   –  Camera settings - General 

•   –  Camera settings - Application 

•   –  Camera settings - System 

•   –  Camera settings - Storage 

•   –  Camera settings - Thermography  

•   –  Frame grabber settings 

•   –  GigE Vision settings 
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•   – Thermography parameters (only visible when thermal calibration pack is 
loaded). 

 

5.9.11.1. Settings Tab – Camera 
The camera specific settings are distributed over different categories – General, 
Application, System, Storage and Thermography. The content depends on the available 
camera features and the implementation thereof.  

For each camera an overview of the available features is available. This can be obtained 
by right clicking on one the features and select “Show property settings” (see Figure 5-81) 
or via the help menu (chap. 5.8.5). This document also contains the programming names to 
be used when the camera is implemented in a custom application using the Xeneth 
software SDK. 

 

Figure 5-81 Camera properties settings tab 

If in the application settings (chap. 5.2.3.2 ) the option Enable SDK tooltips is activated the 
programming names and values are shown in a tooltip as well. 

5.9.11.2. Settings Tab – Frame grabber settings 
When a Camera Link camera is connected via one of the Xeneth integrated Camera Link 
frame grabbers, the parameters to configure the frame grabber are listed here. Typical 
settings are: 

• Frame count – Defines the amount of buffers the frame grabber software sets apart 
for grabbing. 

• Mode – Defines the buffer management.  
o Preview: The frame grabber is suggested to use its buffers as ring buffer. 

The latest image is always stored even if the previous image at that location 
is not yet read out by the application.  

o Synchronous burst: All buffers are filled only once. Capturing is halted 
afterwards. All images are read from the buffer. 

o Synchronous bursts: Continuous loop of synchronous bursts. A new series 
of images is captured as soon as the application did read all the available 
images. 
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• Timeout – The maximal time that the frame grabber is waiting before it returns.   

5.9.11.3. Settings Tab – GigE Vision 
• Packet delay – The delay (in timestamp counter units) between consecutive data 

packages on the stream channel.  
• Packet size – The size of data packages (in bytes) on the stream channel. 
• Retry count – The maximal number of times Xeneth retries to set a control register 

when no acknowledge is received. 
• ACK timeout – The time Xeneth waits for an acknowledge after a control register is 

set. 
• Pass frames with lost packages – When false, frames with missing parts are 

dropped. 
• Use packet resend – When active, the Xeneth will ask the camera to resend a 

package that is missed. 
• Frame drops – The number of frames that are lost since start of capture. 
• Packet drops – The number of packages that are not received by Xeneth. 

5.9.11.4. Settings Tab – Thermography 
The following features can be found here: 

• Ambient temperature 
• Emissivity map 
• Atmosphere temperature 
• Atmosphere transmission 
• Window temperature 
• Window reflected temperature 
• Window transmission 
• Window reflection 
• Optics f number 

In the Selections tab (see chap. 5.9.3) you can define a per selection emissivity. This 
emissivity will be combined with the above parameters to compute temperatures based on 
the model described in chap.6.3. 

To compute the value of the atmosphere transmission as a function of the distance, the 

dialog under the blue wrench icon ( ) can be used. (See Figure 5-82 Transmission 
calculator.) 
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Figure 5-82 Transmission calculator 

 

Emissivity map 

 

Figure 5-83 Emissivity map 

The emissivity map defines the default emissivity values in a selection. 

Explanation of the icons: 

 Set an emissivity map (.xepng) / Convert a thermal frame to an emissivity map 
(providing that an object was heated to a known temperature) 

 Save an emissivity map (.xepng) 
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 Clear the actively loaded emissivity map. 
 

 

Figure 5-84 Emissivity maps example 
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Settings for InGaAs Thermography 

 

Figure 5-85 InGaAs thermography settings 

For InGaAs thermography there is an additional parameter (see Figure 5-85): 

• Optics F number – Can be read on the lens, usually spans from 1.4 to 16 

5.9.12. Scale 
 

 

 

 

 

 

 

 

 

 

 

Figure 5-86 Scale 

The Scale ( ) allows to focus on the adu or temperature range of interest in the X-
View pane by moving the min and max sliders.  

Top icon description: 

 Lock – Locks the span (temperature/adu range), in effect moving either slider causes 
the fixed thermal window to slide. 

 Restore full range – Resets the span to the full span the camera is able to image. 
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Snap span to histogram – Sets the range to match the image histogram. 

  

Figure 5-87 Scale – Snapped span 

 Select color map – Allows the selection of a different color map to apply to the image. 

 Invert palette – Inverts the active palette.  
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5.9.13. Recording Tab 
 

5.9.13.1. Recording 
If the Recording tab is missing, enable it through the “View” menu (chap. 5.8.2). 

  

Figure 5-88 Recording tab 

Explanation of the settings: 

• Location – The file to save the movie in, be it XVI (raw 16 bit) or AVI (raw 8 bit) 
• Framerate decimation – Frames are skipped during recording.  
• Limit mode – When selecting Limit the maximal amount of frames that can be stored is 

set in Number of frames. Otherwise the size of the movie is limited by the available disk 
space. 
Number of frames – When setting the Limit Mode to Limit the maximal amount of 
frames that can be captured is set here.  

• Diskspace – Available space on the drive Location refers to. 
• Memory mode – Pre-triggering/buffering 
• Minimize CPU usage to optimize recording speed – Attempt to save some CPU cycles 

by simplifying the interface. 
• Record with settings – Allows to 

o include user comments in the movie, 
o select camera settings that only will be applied during recording. 
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5.9.13.2. Recording using Settings 

 

Figure 5-89 Record with settings 

The settings in this pane will be activated when the recording is started.  
This can for instance be used to configure triggering. 

5.9.13.3. Recording Memory Modes 

 

Figure 5-90 Record memory modes 

Explanation of the parameters (see Figure 5-90): 

• Unused – Off 
• Store then write – First save the recording to the PC memory and afterwards write to 

disk. 
• Buffer – Record to PC memory in a rotating buffer, write to disk when the CPU has time 

available. 
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• Pre-triggering – Explained in chap. 5.9.13.4. 

 

5.9.13.4. Recording – Pre-triggering 

 

Figure 5-91 Recording – Pre-triggering 

Pre-triggering makes it possible to get information before and after a trigger event. The 
trigger sources include camera trigger signals, and image triggering results. 

 

5.9.13.5. Recording and calibration packs 
When a (NUC) calibration pack is loaded and the software correction filter is not activated 
while recording an XVI movie, uncorrected images are stored and the name of the 
calibration pack is added to the file as meta – data.  

In this case the mentioned calibration pack can be used to correct the data from the movie 
during playback. 

When a (NUC) calibration pack is loaded and the software correction filter is activated while 
recording an XVI movie, corrected images are stored and the name of the calibration pack 
is added to the file as meta – data. 

In this case it is not possible to revert to uncorrected data during playback. 

When a calibration pack containing temperature calibration data is loaded and the thermal 
filter is activated while a movie is recorded a ADU to temperature lookup table is stored in 
the XVI file.  

In this case it is possible to make a temperature analysis of the recorded data – even 
without the original calibration pack. Moreover it is possible to use selections and apply all 
radiometric corrections. (See chap. 6.2 to chap. 6.4.) 
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5.9.13.6. Playback overview 

 

Figure 5-92 Playback button 

This button makes it possible to play back an existing recording from disk. Notice that a 
second instance of Xeneth will be started in which the virtual camera is connected. When 
Xeneth was started with the virtual camera, no new instance will be launched. 

After the video is loaded the Recording tab contains the following elements (see Figure 
5-93): 

 

Figure 5-93 Playback a recording from disk 
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Overview of the playback control buttons (see Figure 5-93): 

 Go to previous (trigger) event. 

 Step back one frame. 

 Set export range initial frame. 

 Start playback. 

 Pause playback. 

 Apply modified frame rate. 

 During playback this cursor shows the current location. Alternatively, the cursor can 
be used as a slider to select the preferred location in the movie. In this case the recorder 
will be paused immediately.  

 Set export range final frame. 

 Step forward by one frame. 

 Go to next (trigger) event. 
 

 Export a selected range to disk. 

 Select all frames for export. 

Explanation of the Playback settings: 

• Rx Time – The time at which the image is received by the software. 
• Tx Time – The time at which the image is transferred by the camera. It is not 

available on all cameras. 
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• Current frame – Frame counter. When the movie is halted, the value is editable and 
can be used to steer the cursor. 

• Frame count – The total amount of frames in the movie. 
• Original frame rate – The frame rate at which images are captured. Expressed in 

frames per second. 
• Playback frame rate – When the Adjust playback framerate button is activated (

) the Original frame is overruled by the Playback frame rate. This allows for 
instance to show the movie in slow motion. 

 
 

Explanation of the export settings: 

• Start Marker – The initial frame of the exported data. 
• End marker – The final frame of the exported data. 
• Selected frame count – The size of the range. 
• Skip frames – Between every set of size defined by Capture frames that is exported 

an amount of frames equal to Skip frames is skipped. 
• Skip frames – Between every set of size defined by Capture frames that is exported 

an amount of frames equal to Skip frames is skipped. 

Explanation of the AVI export settings: 

• Add scale overlay – Add a copy of the Scale (See chap 5.9.12 Scale) to every 
frame. 
 

Explanation of the file information: 
• Name – File path  
• Recorded using – Xeneth version that was used for recording. 
• Recorded on – Recording date and time 
• Header info – XVI header info 
• Calibration file – The calibration file that was active during recording. 
• Notes – User notes as defined in the “Record with settings” panel. See chap. 

5.9.13.2 Recording using Settings. 

5.9.13.7. Playback export 

The ( ) button allows to export a part of an XVI movie to another XVI movie, a 
AVI movie or to a set of separate images. 

Selecting the frames that end up in the exported data can be done as follows: 
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1. Select the initial frame by placing the slider ( ) at the desired location and click 

on the left scissor button ( ). 

2. Select the final frame by placing the slider ( ) at the desired location and click on 

the right scissor button ( ). 
3. The selected range is colored bleu: 

 

 

Figure 5-94 Selected range. 

4. The ( ) button can be used to clear the selection of the range and set it to 
its default range. 

5. Define a subset of the selected range by changing the values for Skip frames and 
Capture frame. Between every set of size defined by Capture frames that is 
exported an amount of frames equal to Skip frames is skipped. 
 

After the Export button is clicked a file selection window will pop up in which a file format 
and a file name can be selected. In case an image format is chosen, each frame will be 
saved in a separate image in which the frame number is added to the selected file name.   

5.9.13.8. Playback camera settings 
When an XVI movie is recorded the active camera settings are stored as well. During 

playback these settings can be consulted via the ( ) icon. 

This feature requires that Microsoft WordPad is installed on your computer. 

5.9.13.9. Time graph synchronization 
In case a movie is loaded, a selection is made in the X-View pane (see chap. 5.9.3 
Selections Tab) and the Time graph (see chap. 5.9.7 Time Graph Tab ) is open, it is 
possible to display the evolution of the selection throughout the movie. This is can be 

achieved by clicking the ( ) icon. 
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5.9.14. Image Processing Tab 
If the Image Processing tab is missing, enable it through the View menu (chap. 5.8.2). 

Adding filters to the image processing ( ) chain is accomplished by 

pressing the Add Filter button at the bottom of the Image Processing tab ( ). 

 

Figure 5-95 Image processing – Add filter 

5.9.14.1. Filter documentation 
By right clicking on the property pane of an image filter a selection pane will pop up that 
allows displaying extra information of the filter.  

 

Figure 5-96  Show property documentation of a filter. 

The documentation explains the different settings for the filter. Moreover, it contains the 
corresponding programming names to be used in combination with the Xeneth software 
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development kit (SDK) and in the Auto start filters setting of the Application settings (See 
chap. 5.2.3.2 User Interface Options. ). 

 

5.9.14.2. Image Processing – Software correction 

 

Figure 5-97 Image processing – Software correction 

 

 

Parameter  Values  Description  
Mode   

Correct The correction is applied. 
Show offset Displays the dark image of the calibration pack. 
Show gain Displays the applied gain values of the calibration pack. 
Pass No correction is applied. 

Replacement   
Adaptive The optimal value is derived from all the neighboring pixels 
Vertical The upper or the lower pixel is copied. 
Vertical interpolation The value is derived from interpolation of the pixels in the 

same column. 
Horizontal The left or right pixel is copied. 
Horizontal 
interpolation 

The value is derived from interpolation of the pixels in the 
same row. 

Lock   
Locked For thermal calibrations, the lock should always be on. 
Unlocked When unlocked the offset and gain multiplier parameters can 

be adapted. 
Keep offset   

No The dark calibration image is subtracted from the image. This 
is the preferred option for non thermal cameras. 

Yes The overall camera signal is kept at the same level. This is 
the preferred option for thermal cameras. 

Offset correction  The dark calibration image is shifted before it is applied. In 
this way the user can avoid that the dark calibration image is 
the lowest possible signal when “Keep offset” is “No”. 

Black clip Between 0 and White 
clip -1 

Output values lower than the black clips are clipped onto the 
black clip. 

White clip Between Black clip + 
1 and maximal pixel 

Output values higher than the white clip are clipped onto the 
white clip. 
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value 
Gain multiplier  An overall gain is multiplied to all the pixels. 
Table 5-4 Software correction parameters 

 

5.9.14.3. Image Processing – Auto Exposure 
 

 

Figure 5-98 Image processing – Auto exposure 

This filter continuously adapts the integration time based on the scene. It should only be 
used together with a TrueNUC calibration pack. 

 

Parameter  Values  Description  

Minimal integration time  
The minimum and maximum integration time is limited 
by minimum and maximum integration time defined in 
the TrueNUC calibration pack. 

Maximal integration time   

Mode 
Top The top of the image histogram is steered towards the 

Target value. 

Average 
The mean of the image histogram is steered to the 
Target value. 

Target value (%)  
The preferred histogram top (average) defined as 
percentage of the maximal digital output value of the 
camera. 

Tolerance (%)  
As long as the histogram top (average) did not change 
more than this value, the integration time is kept 
stable. 

Outliers (%)  
The extreme values of the image histogram are not 
taken into account when searching a suitable 
integration time. 

Table 5-5 Auto exposure parameters 
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5.9.14.4. Image Processing – Sharpening 

 

Figure 5-99 Sharpening filter 

Sharpen all features in the scene. This filter has no adjustable parameters. 

 

5.9.14.5. Image Processing – Auto offset and gain 

 

Figure 5-100 Auto offset and gain filter 

Improve the representation of the usable information in the image by automatically shifting 
and spreading the actual pixel values in the image over the entire available range.  
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Parameter Values Description 
Offset control Automatic; Manual Select automatic or manual offset control. 
Gain control Automatic; Manual Select automatic or manual gain control. 
Auto mode update Running; Stopped Allow the filter to change offset and gain in auto mode. 
Offset used (%) (read only) Shows the currently applied offset level (% of ADU range). 
Gain used (read only) Shows the currently applied gain factor. 
Offset (%) -99.9% to 99.9% Use this offset (% of ADU range) if in manual offset mode. 
Gain 1 to 256 Use this gain factor if in manual gain mode. 
Output histogram 
midpoint (%) 0.1% to 99.9% 

Target level for the histogram midpoint if in auto offset 
mode. 

Maximal gain 1 to 256 Maximal applied gain factor if in auto gain mode 

Regulation speed 0 to 9 
Select how quickly changes in scene result in changes in 
filter parameters. Higher numbers result in slower 
adjustment. 

Outliers expressed as 
% of image size; 
% of maximal intensity 

Select how ‘Dark’ and ‘Bright’ settings are interpreted. 

Dark (%) 0% to 100% 
Percentage of dark pixels to ignore in the histogram. If the 
mode is ‘intensity’, this is absolute % of the ADU range. 

Bright (%) 0% to 100% Percentage of bright pixels to ignore in the histogram. If 
the mode is ‘intensity’, this is absolute % of the ADU range 

Bright display colour White; Black 
Force the colour of bright pixels. If set to ‘white’, outliers 
remain unaffected. 

Input histogram begin 
(%) 0% to ‘midpoint’ 

After clipping outliers, set the beginning of the input 
histogram to this % of the resulting histogram span. 

Input histogram 
midpoint (%) 

‘begin’ to ‘end’ Same for midpoint. 

Input histogram end 
(%) 

‘midpoint’ to 100% Same for end. 

Offset X 0 to sensor width – 1 X coordinate of the top-left corner of the window of interest 
Offset Y 0 to sensor height – 1 Y coordinate of the top-left corner of the window of interest 
Width 1 to sensor width Width of the window of interest. 
Height 1 to sensor height Height of the window of interest. 
Table 5-6 Auto offset and gain filter parameters 

5.9.14.6. Image Processing – Histogram equalisation  

 

Figure 5-101 Histogram equalisation filter 

Improve the representation of the usable information in the image by dividing the image 
into regions and redistributing the actual pixel values in the region over the entire available 
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range. Alternatively, the image can be adjusted based on only input information from 1 
specific window of interest. In this mode, no subdivision into regions will take place. 

Parameter Values Description 
Mode Regions; Window Select full-frame sub regions or single window of interest. 
Clip limit (%) 0 to 100% Limit the amount of redistribution of pixels to equalize the histogram. 
X regions 1 to 8 Divide the image in the defined amount of columns. 
Y regions 1 to 8 Divide the image in the defined amount of rows. 
Offset X 0 to sensor width - 1 X coordinate of top-left pixel of window of interest. 
Offset Y 0 to sensor height - 1 Y coordinate of top-left pixel of window of interest. 
Width 1 to sensor width Width of window of interest. 
Height 1 to sensor height Height of window of interest. 
Table 5-7 Histogram equalisation filter parameters 

5.9.14.7. Image Processing – Noise reduction 

 

Figure 5-102 Noise reduction filter 

Reduce noise in uniform regions of the frame while preserving edges. 

Parameter Values Description 
Filter size 1 to 8 Set the range of pixels used to filter the noise. 
Contrast (%) 0 to 100% Set the contrast level the filter will use to determine the noise and the edges. 
Table 5-8 Noise reduction filter parameters 

 

5.9.14.8. Image Processing – Thermography 

 

Figure 5-103 Image processing –Thermography 

This pane is purely informational; it shows the thermal range available and the type of 
thermal conversion. 
And, in case of an error it displays an error message in its status field. 
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5.9.14.9. Image Processing – Image averaging 

 

Figure 5-104 Image processing – Image averaging 

The image averaging filter makes it possible to reduce the visible noise by averaging a 
configurable number of frames. 

5.9.14.10.  Image Processing – Scale Overlay 

 

Figure 5-105 Image processing – Scale overlay 

 

 

 

 

 

 

 

 

Figure 5-106 Image processing – Thermal scale 

The scale overlay filter makes it possible to show an in-view thermal scale (see Figure 
5-106). 
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5.9.14.11. Image Processing – Overlay 

 

Figure 5-107 Image processing – Overlay 

The overlay filter makes it possible to display a logo (for promotional purposes) in any of 
the image corners, and in the center. 

5.9.14.12.  Image Processing – Matrix 
 

 

Figure 5-108 Image processing – Matrix 

 

5.9.14.13.  Image Processing – Lua - Iso Gradient 

 

Figure 5-109 Image processing – Lua - Iso gradient 

 

 

 

 

 

Figure 5-110 Lua – Iso gradient example 
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The general purpose scriptable Lua filter with the Iso Gradient example loaded  
(see Figure 5-110). 
This filter also emits an image triggering event when a scene possesses elements that 
match the configured thermal interval. 

5.9.14.14.  Image Processing – Lua - Spot Meter 

 

Figure 5-111 Image processing – Lua - Spot meter 

 

 

Figure 5-112 Spot meter overlay example 

This spot meter overlay example is nice for third party thermographic applications. 

5.9.14.15.  Image Processing – Lua - Crosshairs 

 

Figure 5-113 Image processing – Lua - Crosshairs 

 

 

 

 

Figure 5-114 Image processing – Lua - Crosshair example 
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5.9.14.16.  Image Processing – Lua - Custom Filter 
The general purpose of the Lua filter is to load custom scripts. Chap. 5.11 General Purpose 
Image Filter – Scripting describes the way to write and load these scripts. 

5.9.14.17.  Image Processing – Recording/Playback 
When a movie is recorded or shown, the recorder or player icon (see Figure 5-115) is 
shown in the Image Processing tab: 

 

Figure 5-115 Image processing – Recorder/player icon 

The movie is recorded in a 16 bit XVI file format, which is the Xenics proprietary file format. 
We refer to the documentation included in the Software Development Kit for a detailed 
description of the format. 

The filters in the Image Processing tab that are active during recording are stored in the 
file, without being applied to the data. This allows the user to (re)analyze the frames 
afterwards, which can be very useful, e.g. if the thermal filter is applied to measure 
temperatures in a scene, but – at that time - do not have correct information on the 
emissivity of the objects and the ambient temperature.  

 Nothing is recorded when the filter parameters are changed during recording 
or when filters are (de)activated. Only their initial state will be captured in the 
XVI.  

 The main exception is the non-uniformity correction (NUC): when a NUC is 
applied during recording, corrected images are stored and it will not be 
possible to switch off the NUC when showing the recorded movie. When no 
NUC is applied, it is possible to activate one while the movie is being played. 

5.9.14.18.  Image Processing – Record AVI 

 

Figure 5-116 Image processing – Record AVI icon 

i 

i 
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The movie is recorded in the 8 bit AVI format, in which case the activated filters in the 
Image Processing tab are applied to the recorded data. In this way a “What You See Is 
What You Get” movie can be shared with third party viewers. The disadvantage is that it is 
no longer possible to analyze the data afterwards. 

5.9.14.19.  Image Processing – XVI Player 

 

Figure 5-117 Image processing – XVI player icon 

When an XVI movie is started, all filters that were active at the start of the recording will be 
activated again. Moreover, also the parameters applied to these filters are remembered. 
Afterwards the user is free to change these parameters, deactivate filters or switch on new 
filters as necessary for the required analyses to perform.  

When a NUC was applied during recording it cannot be switched off. The NUC that was 
loaded is shown in the ‘Calibration’ item in the Recording tab. When it was applied, the 
‘[Data is corrected]’ message is shown, if not ‘[Data is not corrected]’ is shown. In the latter 
case, it is possible to activate any NUC. 

 

5.9.14.20.  Image Processing – Filter Priorities/Ma nagement 
For filters, not managed by Xeneth, the order in which filters operate on the image data can 
be changed by using the following buttons: 

 

Figure 5-118 Image processing – Filter management 

Explanation from left to right: 

• Collapse filter settings 
• Move filter up 
• Move filter down 
• Remove filter from the filter stack 
• Save active filter settings to disk 
• Load active filter settings from disk as shown in Figure 5-119. 
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Figure 5-119 Load active filter settings from disk 

Filters can also be temporarily switched off, by pressing the filter icon (see Figure 5-120): 

  

Figure 5-120 Disable filter 

Filters can also be temporarily switched on, by pressing the filter icon (see Figure 5-121): 

  

Figure 5-121 Enable filter 
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5.9.15. Alarms 
If the Alarms tab is missing, enable it through the “View” menu (chap. 5.8.2). 

Using the alarms pane, it is possible to receive audible/programmatic responses to image 
filter / selection threshold events (See also chap. 5.9.3 Selections Tab and chap. 5.9.14 
Image Processing Tab). 

 

Figure 5-122 Alarm settings 

Explanation of Figure 5-122: 

Parameter Parameter options Description 
Trigger source   
 Any Responds to all events. 
 Events – Image processing Responds to events generate by an image filter. 
 Events – Selection alarms Responds to selection events only. 
Actions   
 Start external program Spawn, and wait for an external process to terminate 
 Play sound Play a .wav file 
 Show message Display a dialog box 
Action delay  Bars the event response from being executed faster than 

every <x>s. 
Table 5-9 Alarm parameters 

5.9.16. Zoom Lens 
If the Zoom lens tab is missing, enable it through the “View” menu (chap. 5.8.2). 

The zoom lens pane provides control for a connected, motorized zoom lens. On 
connection, the panel will display the current zoom and focus positions of the lens on the 
sliders. 

Basic connection status information is presented in the ‘Status’ field (‘Disconnected’ and 
‘Connected on port: xxx’). The name field shows the protocol used with the currently 
connected lens. 

The zoom and focus position of the connected lens can be adjusted by moving the 
respective sliders. 
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Figure 5-123 Zoom lens pane 

Zoom lenses compatible with the Ophir U3 and IRZoom protocols are supported. 

5.9.17. Status Bar 
 

Figure 5-124 Status bar 

Explanation of Figure 5-124: 

Parameter Description 
#14980 Current frame number 
49 fps Effective data rate achieved over the current frame transport 

(usb/ether/…). 
31061 kb/s Number of kilobytes / second (fps * w * h * pixelsize / 1024). 
Time: The time the frame was taken with microsecond accuracy (this is also 

available during movie playback). 
Table 5-10 Status bar parameters 
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5.10. Troubleshooting 
The issues listed in this section focus on problems that may occur when working with the 
Xeneth software. Make sure to also check out the camera specific user manuals to learn 
about potential problems for your camera.  

5.10.1. Troubleshooting Camera Detection Problems 

5.10.1.1. Ethernet Cameras 
This section handles the absence of a zero configuration networking support. 

If the camera does not have zero configuration support 
(http://en.wikipedia.org/wiki/Zeroconf ), and it must be plugged into a network without a 
DHCP server (http://en.wikipedia.org/wiki/Dhcp ), it is necessary to manually assign an IP 
address to both the computer and the camera (refer to the per camera documentation). 

After having set a fixed address e.g. 192.168.0.2 on your camera, proceed to: 

 �  � 

 

Figure 5-125 Select network 

Select ‘Local area connection 1’ and right-click to select its properties (as shown in Figure 
5-126). 

 

Figure 5-126 Select network properties 
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Figure 5-127 Select network properties – TCP/IP 

Select ‘Internet Protocol (TCP/IP)’ and click the ‘Properties’ button (as shown in Figure 
5-127). 

 

Figure 5-128 TCP/IP properties 

The address in the ‘IP address’ field (in Figure 5-128) is not the same as the one assigned 
to the camera (camera = 192.168.0.2 in the example). 

The subnet mask is correct. 
For every field in the IP address that is different between camera and the PC put a 0 in the 
subnet mask instead of a 255.  
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5.10.1.2. GigE Vision Cameras 
When a GigE Vision camera does not appear in the enumeration list it could be that its 
persistent IP address does not belong to the local sub network. These cameras can be 
recovered by the “Ignore subnet” settings of the camera enumeration settings (see chap. 
5.2.2) and the Force IP mechanism for GigE Vision cameras (see chap. 5.2.1.4). 

 

5.10.1.3. USB Cameras 
When any new hardware detected dialogs from Windows pops up during operation of the 
camera (this sometimes happens when it is plugged into a different USB port), guide 
Windows through the process of re-discovering the driver (see Figure 5-129, Figure 5-130 
and Figure 5-131). 

 

Figure 5-129 USB camera – Windows connection 
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Figure 5-130 USB camera – Select automatic installation 

 

Figure 5-131 USB camera – Driver installation completed 

If these steps did not resolve the issue, refer back to chap. 3.3.1 Camera Drivers (USB). 
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5.10.1.4. Serial cameras 
Always make sure the correct cables are used and all connections are properly plugged 
into the designated connectors. Refer to the camera user manual to learn how to set up the 
connection. When a camera connected using the correct serial cable cannot be detected it 
is possible that the configured range of serial ports to look for is not valid. By default 
Xeneth will only scan ports from COM1 up to, and including, COM4. Usually the serial port 
will have an identifier assigned by the operating system within this range. It is possible to 
extend this range if the assigned port exceeds the default range. The COM port low and 
COM port high values can be found on the Enumeration settings - tab in the Connection 
Setup -dialog. Moreover, make sure the protocol is enabled by setting the “Enumeration 
settings � Enable protocols � Serial”-setting to “True”.  
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5.10.2. Troubleshooting Frame Rate Performance Prob lems 

5.10.2.1. Register Polling 

 

Figure 5-132 Register update 

Register polling (see Figure 5-132) impacts the frame rate on network cameras where the 
bandwidth requirements are already quite big (e.g. 117 fps 640x512). 
Reducing/disabling the register read interval makes it possible to achieve better a 
performance. 

 

5.10.2.2. Graph Updates / Resizing the View 
Changing the Update graphs very x frames in the application setting (chap. 5.2.3) to a 
higher value and disabling the resizing of the view window reduces the CPU load. 

 

5.10.3. Troubleshooting Recording Rate Problems 
When encountering a drop in frame rate while recording in Xeneth closely examine your 
hard drives sustained write speed.  

When the Task Manager of your PC indicates that Xeneth is constantly running at 100% 
CPU load, it may be worthwhile to flag the Minimize CPU usage to optimize recording 
speed tick box in the disk recorder (see Figure 5-133 and Figure 5-134). This causes the 
GUI to revert to a minimal state avoiding any unnecessary drawing operations. 

 

 

Figure 5-133 Disk recorder option 
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. 

 

Figure 5-134 Recording tab 

5.11. General Purpose Image Filter – Scripting 

5.11.1. Setup and Tools 
Chap. 5.9.14.16 did introduce the general purpose Lua image filter. Xeneth allows users to 
write custom scripts that can be loaded in this filter. After the installation, the Xeneth scripts 
are put in the ‘C:\Program Files\Xeneth\Scripts\Filters’ directory, which is the default 
location for the filter to start looking for scripts. It is possible to put the scripts anywhere 
else on the computer as well. 

Lua (http://www.lua.org) is the used scripting language. It is a small, well documented and 
easy to learn programming language. Other nice tools that can help the development are 
the editor Notepad++ (http://notepad-plus-plus.org) that provides syntax highlighting and 
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DebugView (http://technet.microsoft.com/en-us/sysinternals/bb896647.aspx) for capturing 
the Lua error messages. 

 

5.11.2. Tutorial 

5.11.2.1. Start 
Add the Tutorial.lua file in the ‘C:\Program Files\Xeneth\Scripts\Filters’ directory and open 
this file in your editor. 

5.11.2.2. Objects 
Xeneth provides the following three base objects: 

• XCamera() to inquire the camera properties 
• XSensorImage() to edit the frame data and the frame overlay 
• XOverlayImage() to load an external image to the overlay of a frame. 

5.11.2.3. Events 
There are several events that are raised while Xeneth processes the frames of the camera. 
Defining a filter means that the script assigns the desired image manipulation to each of the 
events. 

The events that are available are: 

• OnFrame(): Image manipulation must be done here 
• OnDrawOverlay(): Image overlay manipulation must be performed 
• OnProcessedFrame(): This step follows after that all the activated filters did process a 

frame. The main goal of this step is doing statistics on the image. 
• OnUpdateSpan(): This event is raised whenever a user changes the Scale (See 

selection on Scale) 
• OnUpdateTint(): This event is used when the integration time of the camera is adapted 
• OnSerialise(): This event is used to update the user interface of the filter to its internal 

settings 
• OnParameterUpdate (): This event warns the filter logic that the user did change some 

parameters. 

 

5.11.2.4. Sample 1: Write Information to DebugView 
The following code (Figure 5-135) writes information to the DebugView. 
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Figure 5-135 Sample 1 – Information to DebugView code 

The output of the ‘GetThermalInterval()’ call  depends on the loaded thermal calibration 
pack. Notice that a Lua construct is used, in which a function is able to return multiple 
values.  

 

5.11.2.5. Sample 2: Add Image to Overlay 
The following code adds an image to the overlay. The image is located in 
‘C:\\TEMP\\overlayImage.png’ directory. 

 

Figure 5-136 Sample 2 – Add image to overlay code 

When e.g. the image is the Xenics logo, the result is shown in Figure 5-137. 
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Figure 5-137 Sample 2 – Add image to overlay 
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5.11.2.6. Sample 3: Add Line to Overlay 
The following code (see Figure 5-138) adds a line to the overlay. 

 

Figure 5-138 Sample 3 – Add line to overlay code 

The SetOverlayPixels() function takes a Lua table as argument. This table contains 
consecutively the x and y coordinates and the red, green, blue and alpha color component 
of the points that needs to be drawn. In this example a red line is placed at the bottom of 
the image (see fig). 

 The starting index of a Lua table is 1 and not 0.  i 
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Figure 5-139 Sample 3 – Add line to overlay 
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5.11.2.7. Sample 4: Change Frame Data 
The following code (see Figure 5-140) changes the frame data. 

 

Figure 5-140 Sample 4 – Change frame data code 

The XCamera:GetPixels() function takes a Lua table as argument containing all the pixels 
of which the frame values must be known. The first entry is the x coordinate of the first 
pixel, the second entry is its y coordinate, followed by the x coordinate of the next pixel and 
so on. The call returns a table with the corresponding pixel values. 

The XCamera:SetPixels() function makes a table of the form {x1_coord, y1_coord, value1, 
x2_coord, ...}. 

The code edits the central pixels in a frame. 



 User Manual 

Xeneth v2.6 

Company confidential.  
This document is the property of Xenics. It may not be reproduced – completely or partially – or passed to a third 

party without written permission from Xenics. 
 
Xenics nv  T +32 16 38 99 00            Doc Ref: ENG-2013-UMN020 
Ambachtenlaan 44  F +32 16 38 99 01  Issue: 001 
BE-3001 Leuven � Belgium www.xenics.com  Date: 27/05/2016 
  XF-104_02/20-01-2012 

 
Page 137 of 152 

 

5.11.2.8. Sample 5: Activate Trigger 
When changing the above sample (Figure 5-140) in the following way (see Figure 5-141), a 
trigger bit is set in the frame’s footer. 

 

Figure 5-141 Sample 5 – Activate trigger code 

When this filter runs while the Xeneth event monitor is activated ( ), an alarm will 
be triggered (see Figure 5-142) when the top left corner of the image is warmer than the 
bottom right one.  

 

Figure 5-142 Sample 5 – Alarm is triggered 

 

5.11.2.9. Sample 6: Define User Interface 
To define a working user interface both the ‘OnParameterUpdate’ and ‘OnSerialise’ calls 
need to be defined. The resulting user interface will be a parameter grid.  

To extend the code in sample 2 in such way that the user is able to define the overlay 
image location, the following sample can be used (see Figure 5-143). 
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Figure 5-143 Sample 6 – Define overlay image location code 

This results in the interface of fig. 

 

Figure 5-144 Sample 6 – New interface created 

The arguments of ‘OnParameterUpdate’ event are the name of the updated parameter and 
its new value. 

The ‘Onserialize’ event is used to define the user interface via a series of xml nodes. Each 
node has a name (StartX), a value (imageStartX) and the following series of attributes:  

• Type: possible values are: ‘int’, ‘float’, ‘bool’, ‘colour’, ‘enum’ 
• Label: the name that will be displayed 
• Range: for an enum, this is a list of names that will be shown in a drop-down list 
• Editable: 0 or 1.  

The double brackets “[[” and “]]” are te Lua syntax for literal strings. 
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The following sample (Figure 5-145, Figure 5-146 and Figure 5-147) exploits more of the 
interface facilities:

 

Figure 5-145 Sample interface facilities – Code part 1 
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Figure 5-146 Sample interface facilities – Code part 2 

 

Figure 5-147 Sample interface facilities – Code part 3 

This code results in the following interface: 
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Figure 5-148 Sample interface facilities – Interface result 

To conclude, Xeneth provides an embedded rgb(r,g,b) function that allows to replace the 
ToRGB function of Figure 5-147 by the following construct of Figure 5-149. 

 

Figure 5-149 Embedded RGB function used 

 

5.11.3. Reference Manual 
The following functions are available: 

XCamera:XCamera 

Description:  Parameterless constructor 

XCamera:GetWidth 

Return Returns the width of the displayed frame. When a window of interest is 
selected, this can be smaller than the pixel width of the camera.  

 

XCamera:GetHeight 

Return Returns the height of the displayed frame. When a window of interest is 
selected this can be smaller than the pixel height of the camera. 
 

XCamera:GetMaxValue 

Return:  Returns the maximal pixel value of the camera. 



 User Manual 

Xeneth v2.6 

Company confidential.  
This document is the property of Xenics. It may not be reproduced – completely or partially – or passed to a third 

party without written permission from Xenics. 
 
Xenics nv  T +32 16 38 99 00            Doc Ref: ENG-2013-UMN020 
Ambachtenlaan 44  F +32 16 38 99 01  Issue: 001 
BE-3001 Leuven � Belgium www.xenics.com  Date: 27/05/2016 
  XF-104_02/20-01-2012 

 
Page 142 of 152 

 

XCamera:GetThermalInterval  

Return When the thermal filter is loaded, this call returns both the lowest and the 
highest value from the calibration pack. When no calibration pack is active 
the return values are 0 and XCamera:GetMaxValue.  
 

XSensorImage:XSensorImage 

Description:  Parameterless constructor 

XSensorImage:SetPixels  

Description Allows to override a set of pixels in the frame data.  
 

Parameters A Lua table of the form {x_1, y_1, v_1, x_2, y_2, v_2, …, x_n,  y_n, v_n} 
contain the x and y coordinates of the n pixels that will be modified, together 
with the new value of these pixels. 

 

 XSensorImage:SetOverlayPixels  

Description Allows to add coloured information (RGBA) to the overlay layer of each 
frame.  
 

Parameters A Lua table of the form {x_1, y_1, r_1, g_1, b_1, a_1, x_2, y_2, r_2, …, x_n, 
y_n, r_n, g_n, b_n, a_n} contain the x and the y coordinates of the n pixels 
where we want to change the overlay of, together with their new RGBA 
colour coordinates. 

 

XSensorImage:GetPixels        

Description Allows to retrieve the frame data from a set of pixels.  
 

Parameters A Lua table of the form {x_1, y_1, x_2, y_2, …, x_n, y_n} containing the x 
and y coordinates of the n pixels of interest. 
 

Return Returns a Lua table of the form {v_1, v_2, …, v_n}. 
 

XSensorImage:GradientTransfer  

Description Allows to define a global colouring scheme on the frame overlay by relating a 
colour gradient to a range of pixel values. The colour scheme is defined by 
its extremal points. Intermediate points are interpolated.  
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Parameters 1. Lowest pixel value in the (inclusive) interval of interest 
2. Highest pixel value in the (inclusive) interval of interest 
3. Red colour coordinate assigned to the lowest pixel value 
4. Green colour coordinate assigned to the lowest pixel value 
5. Blue colour coordinate assigned to the lowest pixel value 
6. Alpha colour coordinate assigned to the lowest pixel value 
7. Red colour coordinate assigned to the highest pixel value 
8. Green colour coordinate assigned to the highest pixel value 
9. Blue colour coordinate assigned to the highest value 
10. Alpha colour coordinate assigned to the highest pixel value. 
 

Return Returns the number of coloured pixels, i.e. the number of pixels in the 
selected output interval. 
 

 

XSensorImage:SetReference  

Description Tags a frame by setting a trigger flag in the footer.  
 

Parameters 1. The string “trigger” 
2. 28-bit filter specific data. 
 

XSensorImage:DrawOverlayImage  

Description Allows to copy an image into the overlay of a frame.  
 

Parameters 1. x coordinate of the first pixel selected from the image 
2. y coordinate of the first pixel selected from the image 
3. width of the selection 
4. height of the selection 
5. x coordinate of the target location 
6. y coordinate of the target location. 
 

 

XOverlayImage: XOverlayImage 

Description Defines an image object that can be placed at the overlay of a frame.  
 

Parameters String that contains the path to the image’s location. 
 

XOverlayImage:GetWidth  

Return:  Returns the width of the image. 
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XOverlayImage:GetHeight  

Return:  Returns the height of the image. 

 

5.12.  Software Development Kit 

5.12.1. Installation 
Aside from installing the runtime (Xeneth.dll and dependencies), the option exists of 
installing the available libraries & headers, documentation and samples as shown in Figure 
5-150. 

 

Figure 5-150 SDK installation setup 

If a new application is being developed based on this SDK, check all the options! 
By default only the runtime is installed, which will eventually be bundled in the application’s 
installer. 

5.12.2. Documentation 
A shortcut to the API documentation will become available in the start menu (see Figure 
5-151): 
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Figure 5-151 SDK documentation 

Select the ‘X-Api-Help’ to open the Xeneth.dll programming reference, or alternatively, 
navigate to the ‘C:\Program Files\Xeneth\Sdk\Help’ to find ‘xeneth-sdk-chm’. The document 
collects the information on the programming interface and Xenics file formats. It also tells 
where to find samples and binaries(.dll, .o), libraries(.lib) and header (.h) files.  
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6. Thermography 
In this chapter we briefly overview of the thermography features in Xeneth. Most of the 
topics that will be discussed are already dealt with at other places of this manual and will 
not be described in detail. The aim is rather to put all these features in the context of 
thermography. 

To take advantage of the thermal capabilities of the software, you need the Radiometric 
version of Xeneth and your camera needs to be calibrated. This means that you received 
either a calibration pack as a so called .xca file or you own a camera that has temperature 
calibration data onboard. 

 

6.1. Select Calibration Data 
When your camera is shipped with a calibration pack (.xca), the pack will be installed 
automatically during the installation of Xeneth. After Xeneth is started and when the 
camera is selected in the list of cameras, the calibration pack will be shown in the 
“Calibration data” drop down list. 

When this is not the case, the calibration file can be imported via the Calibration menu (see 
chap. 5.8.4) or put manually in the calibration folder.  The default path of this folder is 
C:\Program Files (x86)\Xeneth\Calibrations or C:\Program Files\Xeneth\Calibrations. 

For cameras that have calibration data onboard, you should select the item “(Camera 
memory)” in the same drop down list.  
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Figure 6-1 Select thermal calibration pack. 

To activate the calibration, use the button in the main tool bar. (See chap. 5.7) 

When the calibration pack loaded contains valid temperature calibration data for the current 

camera or when the temperature calibration data is stored on the camera a ( ) icon will 
appear on top of the thermography settings tab. (See chap. 5.9.11.3 Settings Tab – GigE 
Vision 
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• Packet delay – The delay (in timestamp counter units) between consecutive data 
packages on the stream channel.  

• Packet size – The size of data packages (in bytes) on the stream channel. 
• Retry count – The maximal number of times Xeneth retries to set a control register 

when no acknowledge is received. 
• ACK timeout – The time Xeneth waits for an acknowledge after a control register is 

set. 
• Pass frames with lost packages – When false, frames with missing parts are 

dropped. 
• Use packet resend – When active, the Xeneth will ask the camera to resend a 

package that is missed. 
• Frame drops – The number of frames that are lost since start of capture. 
• Packet drops – The number of packages that are not received by Xeneth. 

Settings Tab – Thermography). 

 

 

Figure 6-2 Image filter temperature settings. 

 

6.2. Software Settings 
The thermography settings tab ( , see chap. 5.9.11.3) collects features that are applied in 
the Thermography software filter. 

• Ambient temperature – Overall ambient temperature of the scene (���� ). 
• Emissivity map – Per pixel emissivity values (�). 
• Atmosphere temperature – The temperature of the medium between the scene and 

the observer (����). 
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• Atmospheric transmission – The transmission factor of the medium between the 
scene and the observer (�). 

• Window temperature – The temperature of a window in front of the camera (�	
�). 
• Window reflected temperature – The temperature reflected at an intermediate 

window and observed by the camera (�	
� �
��). 

• Window transmission – The transmission factor of the window ( �). 
• Window reflection – The reflection factor on the window (�). 

6.3. Radiometry 
The radiance that is observed by a camera when it is pointed to an object is affected by the 
following components: 

• the energy radiated by the object, 
• the energy from the environment reflected on the object, 
• the energy radiated by the atmosphere between the object and the camera, 
• the energy absorbed by the atmosphere between the object and the camera, 
• the energy radiated / absorbed / reflected by a window between the object and the 

camera. 
 

By combining these elements the observed irradiation (����
��
�) by a camera that looks to 
an object of temperature (�) can be approximated by: 

����
��
� =  ����
��+��
���
��
� �� ���
�� + ��������
�
 + � 
���	 + ��
��
��
� �� 	
���	, 

where 

����
�� =  � ∗ � ∗ � ∗ �""#����$ 

��
���
��
� �� ���
�� = (1 −  �) ∗ � ∗ � ∗ �""(����) 

��������
�
 = (1 − �) ∗ � ∗ �""(����) 

� 
���	 = (1 −  � −  �) ∗ �""(�	
�) 

��
��
��
� �� 	
���	 = � ∗ �""#�	
� �
��$ 

in which 

• �""(�) is the radiated energy of a perfect black body at temperature �, 
• ���� is the temperature of the object. 
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All other symbols are as defined above.  

 

6.4. Temperature Readings 
As soon as a thermal calibration is activated, temperatures can be read at different places: 

• The scale (chap. 5.9.12) reflects the selected thermal range. 
• When a calibration pack is activated in software, the statistics describing a selection 

are expressed in temperature (chap 5.9.3).  
• The Histogram (chap.5.9.5), Graph (chap. 5.9.6) and Time Graph (chap.5.9.7) are 

expressed in temperatures.  
• XPNG images can be saved (chap.5.8.3 and chap. 5.8.3.5). 

Temperatures can be read in degrees of Celsius, Kelvin and Fahrenheit. This can be 
selected in the Application settings (chap. 5.2.3.2). 

6.4.1. Temperature Readings and Image Filters 
When an image filter is activated (chap 5.9.14), it affects the image and hence the 
temperature reading. This could be the desired behavior – for instance when the filter 
reduces noise - but this is not always the case. Indeed, by applying filters that alter the 
histogram all thermal information could be lost.  

In the Application settings (chap. 5.2.3.2), you can find the item “Measure thermal filter data 
only” which determines whether thermal information is extracted immediately after the 
thermal filter or only after all image filters are applied.  

6.4.1.1. Loading Thermal Images 
When thermal images (.xpng) are loaded (see chap. 5.8.3.1), the Show Image filter is 
activated and the image is shown on top of the live image. In this case it is very likely that 
you want to read temperatures after the filter. This implies that Measure thermal filter data 
only should be put to False. 

6.5. Thermal data in XVI movies 
When an XVI movie is recorded while a temperature calibration is loaded and the 
thermography software filter is activated, calibration data are stored in the XVI as meta-
data. 

When playing back this movie the calibration data can be applied. 

Start Xeneth, select the Virtual camera and select as Calibration data (none).  
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Select and start the movie. 

Click ( ) to activate the thermography filter. 

 

Figure 6-3 Movie thermal data 

6.6. Onboard Settings 
For cameras that have a temperature calibration onboard, the features listed under the (
) tab are camera settings. This means that the values you enter here are passed to the 
camera that makes the needed computations. Which features are available is camera 
depended.  

Typical settings are: 

• Minimal temperature - the lowest temperature that can be measured, 
• Maximal temperature – the highest temperature that can be measured, 
• Selection minimal temperature – the minimal temperature as selected by the user, 
• Selection maximal temperature – the maximal temperature as selected by the user, 
• Emissivity – the overall emissivity of the scene,  
• Ambient temperature – the overall ambient temperature of the scene. 

We refer to the camera manual for more details.   

In case those cameras are used in Xeneth the camera settings that you find here are 
mastered by the software and need not to be modified. Use the thermography settings tab 
instead. (See chap. 5.9.11.3  and chap.6.2.) 

6.6.1. Serval  
The Serval family of cameras could contain several sets of correction data (for instance to 
be used for different lenses) and temperature calibration data.  
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A temperature calibration can be activated as follows: 

1. Select the onboard calibration data (See chap. 6.1.). 
2. Go to the Settings tab > Camera > Image correction control > Source control > 

Source and select one of the items Calibration 1 to Calibration 2. 
If the selected source does contain temperature calibration data then 

• the feature Camera( ) > Image correction control > Source control > 
Thermography enable will have the value On, 

• the feature Thermal( ) > Thermography > Temperature control > Minimal 
temperature and Thermal > Thermography > Temperature control > 
Maximal temperature do contain the minimal and the maximal calibrated 
temperatures.  

3. Click on the icon  (See Figure 6-2 Image filter temperature settings.) to activate 
the software image filter that converts the camera output to temperatures. 

4. Read temperatures as described in chap.6.4. 

 

  


